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Legal Notices
Warranty
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additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices
© Copyright 1994–2008, Hewlett-Packard Development Company, L.P.
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Copyright 2000, 2004 IBM Corporation and others. All rights reserved. Copyright 2001-2004 Kiran Kaja 
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copyright © 2002, Chris Grindstaff. Part of the software embedded in this product is gSOAP software. 
Portions created by gSOAP are copyright © 2001-2004 Robert A. van Engelen, Genivia Inc. All Rights 
Reserved. Copyright © 1991-2005 Unicode, Inc. All rights reserved. Distributed under the Terms of Use in 
http://www.unicode.org/copyright.html.

Trademark Notices
Java™ and all Java based trademarks and logos are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries.
Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.
Unix® is a registered trademark of The Open Group. 
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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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1 Planning for an HP Service Manager 
Implementation
This chapter describes the ways in which you can implement HP Service 
Manager 7.10 in your organization.

Topics in this section include:

• Types of Installation Environments on page 12

• Components of a Production Environment on page 13

• Implementation Checklist on page 18
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Types of Installation Environments

You can install Service Manager in several types of environments:

• Production environment

• Non-production environments

— Development environment

— Test environment

— Reporting environment

Production Environment

Installing Service Manager in a production environment allows you to deploy 
your customizations and provide services to your intended user base. Most 
production environments run 24 hours a day and 7 days a week, support many 
simultaneous users, and process large numbers of transactions and requests. 
In a production environment, you typically install the various components of 
Service Manager on dedicated servers to maximize system performance.

Non-Production Environments

The following sections describe some of the common non-production purposes 
for which you can install Service Manager.

Development Environment

Installing Service Manager in a development environment allows you to 
evaluate application features and customize your installation prior to 
deployment in a production environment. In a development environment, you 
typically install all Service Manager components on one test system with a 
limited number of users and data.
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Test Environment

A test environment is an installation that mirrors your production 
environment where you can test performance, upgrades, and backup and 
restore procedures. In a test environment, you typically install Service 
Manager in the same configuration as your production environment.

Reporting Environment

A reporting environment is an installation that mirrors the data from your 
production environment that you can use to generate and view reports. In a 
reporting environment, you typically install Service Manager to synchronize 
data with your production environment but limit the number of users that 
access the system.

Components of a Production Environment

A production environment consists of the following components:

Table 1 Components of a production environment

Tier Requirement Components

Client tier Mandatory Web clients (optional)
Windows clients

Server tier Mandatory Service Manager server

Database tier Mandatory RDBMS on separate server (required)

Web tier Optional Web application server on separate server
Web server on separate server
Service Manager webtier-7.10.war file deployed

Supporting servers Optional Help Server

Additional connections  
and integrations

Optional HP products
Web services
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Client Tier

The client tier consists of two components:

• web client (optional)

• Windows client

The web client allows users to connect to the Service Manager server by using 
a web browser. You must install the web tier to support web clients. You do not 
need to install or download any additional software on the user’s desktop.

The Windows client allows users to connect to the Service Manager server 
through a dedicated client. You must install the Windows client separately on 
each system that you want to connect to Service Manager.

See the What's New in Service Manager 7.10 online help for a list of 
differences between the web and Windows clients.

Server Tier

The server tier consists of the Service Manager server. The Service Manager 
server runs the Service Manager applications and manages the connections 
between the client and web tiers to the database tier.

See the What's New in HP Service Manager 7.10 online help for a list of 
changes to the Service Manager server. See the HP Service Manager 7.10 
Upgrade Guide before upgrading your server.

Database Tier

The database tier consists of one or more supported RDBMS servers. Your 
Service Manager application data must reside on an external RDBMS server.

For more information, see Database Preparation on page 21.
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Web Tier

The web tier is an optional feature that consists of the following components:

• Web application servers

• Web servers

• Service Manager webtier-7.10.war file

The web application servers are third-party server software where you deploy 
the webtier-7.10.war file to support connections from Service Manager web 
clients.

The web servers are third-party server software that provide the HTTP or 
HTTPS content to Service Manager web clients. Some web application servers 
also include built-in or bundled web servers.

The Service Manager webtier-7.10.war file is a web archive that you must 
deploy to a compatible web server to support connections from Service 
Manager web clients.

See the Service Manager Compatibility Matrix for a list of acceptable web 
application servers and web servers. The HP Support matrices require that 
you register as an HP Passport user and sign in.

To register for an HP Passport ID, go to: 
http://h20229.www2.hp.com/passport-registration.html.

If you already have an HP Passport account, go to: 
http://support.openview.hp.com/sc/support_matrices.jsp.

Help Server

The Help Server is a preconfigured web server that provides HTML Help to 
Service Manager clients and as a stand-alone web page. See Help Server 
Installation on page 99 for more information on this optional feature.
Planning for an HP Service Manager Implementation 15

http://h20229.www2.hp.com/passport-registration.html


Additional Integrations

The following HP products are integrated with the HP Service Manager 
server: 

• HP Asset Manager (through Connect-It)

• HP DecisionCenter (through Connect-It)

• HP UCMDB (through Connect-It)

• HP Business Availability Center (through Connect-It)

• HP Configuration Management (through Connect-It)

• HP Operations Manager for Windows (through SCAuto)

• HP Operations Manager for Unix (through SCAuto)

• HP Network Node Manager (through SCAuto)

See the Service Manager Compatibility Matrix for a complete and up-to-date 
list of HP integrations. The HP Support matrices require that you register as 
an HP Passport user and sign in.

To register for an HP Passport ID, go to: 
http://h20229.www2.hp.com/passport-registration.html.

If you already have an HP Passport account, go to: 
http://support.openview.hp.com/sc/support_matrices.jsp.
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These components are logically connected as depicted in the following 
diagram:
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Implementation Checklist

The Service Manager 7.10 release offers a wide variety of significant new 
features. There are various configuration and deployment options that you 
should consider from the start to maximize the benefits of the product, ease its 
integration into your environment, and provide a foundation for future 
support and updates. The checklist below provides considerations and 
recommended steps that you can incorporate into your implementation and 
upgrade plans.

Follow these steps to implement Service Manager:

1 Determine the hardware required for your Service Manager production 
environment.

For an estimate of the server hardware required, see the Basic Server 
Sizing Worksheet for instructions. This worksheet is available for 
download from the Customer Support web site’s Knowledge Base.

2 Are you upgrading from ServiceCenter?

Yes. See the HP Service Manager 7.10 Upgrade Guide for instructions.

Are you migrating from Service Desk to Service Manager 7.10?

Yes. See the HP Service Manager 7.10 Migration Guide for instructions.

3 Configure a connection to your RDBMS.

See Database Preparation on page 21 for instructions.

4 Install Service Manager server in a development environment.

See Server Installation on page 35 for instructions.

5 Determine the clients (Windows and/or web) that will connect to Service 
Manager.

See the Choosing Clients Worksheet for instructions. This worksheet is 
available for download from the Customer Support web site’s Knowledge 
Base.

6 Do you need to install Windows clients?

Yes. Review the Windows client installation requirements. See Client 
Installation on page 69 for instructions.
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7 Do you need to support web clients?

Yes. Install the Service Manager web tier in a development environment. 
See Web Tier Installation on page 79 for instructions.

8 Do you want to provide online help?

Yes. Install the Help Server. See Help Server Installation on page 99 for 
instructions.

No. Go to step 9.

9 Do you want to make customizations to your Windows clients such as 
changing the splash screen, adding custom images, adding company 
branding, adding default settings and connections, and configuring 
connections to a Help Server?

Yes. Install the Client Configuration Utility. See Client Configuration 
Utility Installation on page 107 for instructions.

No. Install Windows clients in your development environment, and then 
go to step 12.

10 Customize a Windows client with the Client Configuration Utility.

See Client Configuration Utility Installation on page 107 for instructions.

11 Deploy the customized Windows client to your development environment.

12 Tailor the Service Manager applications to your environment.

a Add or update the operator records in your development environment 
with new capability words.

See the Service Manager online help for instructions on adding new 
operators and a list of new capability words.

b Optimize the Service Manager interface in your development 
environment. For example, you can add public favorites and 
dashboards, tailor forms for viewing in the web tier, and tailor forms 
for accessibility-assisted users.

See the Service Manager online help for instructions on adding new 
favorites and dashboards, tailoring forms for the web tier, and 
addressing the needs of accessible-assisted users.

c Configure the Service Manager server to accept connections and 
integrations from external data sources and applications such as 
Change Calendar, Connect-It, Decision Center, and Web Services.
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See the Service Manager online help for instructions on enabling 
integrations to other applications.

See the Service Manager Compatibility Matrix for a list of 
applications that can connect to and share data with Service Manager. 
The HP Support matrices require that you register as an HP Passport 
user and sign in.

To register for an HP Passport ID, go to: 
http://h20229.www2.hp.com/passport-registration.html.

If you already have an HP Passport account, go to: 
http://support.openview.hp.com/sc/support_matrices.jsp.

13 Test your development environment.

Review your client and server customizations, client connections, and 
overall system performance. Correct any problems and retest the 
development environment.

14 Convert or push your development environment to your production 
environment.

To convert the development environment connect the Service Manager 
server to your production environment network and deploy necessary 
clients to the production environment.

To push the development environment to your production environment, 
create an unload file of your application and operator customizations and 
load the file into your production environment system. See the Service 
Manager online help for instructions.
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2 Database Preparation
This chapter explains database configuration requirements that must be met 
prior to installing the HP Service Manager database into your Relational 
Database Management Systems (RDBMS).

This chapter should be reviewed by system and database administrators 
preparing to install the HP Service Manager server.

Topics in this section include:

• General Space Requirements on page 22

• Server connections on page 22

• Login ID on page 22

• Setting up time zones for RDBMS reporting on page 23

• Enabling connectivity on page 23

• IBM DB2 Universal Database Preparation on page 24

• Microsoft SQL Server Preparation on page 26

• Oracle Server Preparation on page 28

• Installing the Sample Database on page 33
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General Space Requirements

If you are establishing a new Service Manager system, allocate at least 1 GB 
of data space for a test system. The amount of space necessary for a 
production system varies depending on the amount of data you need to store 
and your specific implementation. 

Server connections

Every Service Manager thread, foreground or background, requires a 
connection to your RDBMS server. Service Manager background processors 
require 17 connections to run. When you configure your database, make sure 
that you allocate enough connections for all of your users. For additional 
information, refer to your RDBMS vendor documentation.

Login ID

Create a login ID and password for Service Manager to use to connect to your 
RDBMS server. The login must have CREATE/ALTER/DROP TABLE 
authority for the target database. When you log in to Service Manager, it 
creates a table in the default table space defined for that login ID. 

Place all Service Manager data in a dedicated table space within a 
single-instance of your RDBMS. This table space must contain Service 
Manager data only. Multiple instances consume more system resources than 
a single-instance solution.

CREATE/ALTER/DROP TABLE authority is only required during 
installation and creation of new Service Manager tables, and only if you allow 
Service Manager to issue the DDL to create tables and indexes. 
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Setting up time zones for RDBMS reporting

If you plan to report on Service Manager data using RDBMS tools, set the 
sqltz parameter in sm.ini file before conversion. 

For information about using the sqltz parameter, see the System Parameters 
topic in the Service Manager Help. 

Enabling connectivity

Service Manager connects to the database through either an ODBC 
connection (SQL Server) or through an RDBMS client (Oracle and DB2 
Universal). 

To set up the connection between the Service Manager application server and 
your RDBMS, you will need the following information:

• Name of the database. 

• Login and password required to connect to the database server. This is the 
login and password created in Login ID on page 22.

The Service Manager initialization file is called sm.ini. It must be present in 
the Service Manager server RUN directory. You can set the Service Manager 
server parameters in the sm.ini file. 

After you create the connection using either ODBC or the utilities for your 
RDBMS client, you can run the configuration utility, which verifies the 
connection and load the system to the RDBMS.

Case Sensitivity

Service Manager only supports case insensitivity on a Microsoft SQL server. If 
you use another RDBMS vendor, you must set the system to be case sensitive.

If you use different time zone settings after conversion, the dates contained in 
reports made by your RDBMS utility may be inaccurate. 
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 IBM DB2 Universal Database Preparation

This section outlines the tuning and optimization recommendations when 
using Service Manager with IBM DB2 Universal Database for Microsoft 
Windows and Unix. These recommendations are intended only as a guide and 
should not be implemented on a production system without extensive testing. 

The following recommendations assume the use of SMS table spaces and the 
implementation of conventional database tuning and performance measures. 
Actual results may vary on a system-by-system basis based on the tuning 
expertise available and hardware and software selections. Complete the 
following procedures prior to the initial load of your database: 

Task 1: Allocate data space large enough to hold your data.

See General Space Requirements on page 22. 

Task 2: Allocate enough additional server connections for all your users.

See Server connections on page 22. 

Task 3: Create a login ID and password for Service Manager to use when it connects to your 
RDBMS server.

See Login ID on page 22. 

Task 4: If you plan to report on Service Manager data using RDBMS tools, set up time zones.

See Setting up time zones for RDBMS reporting on page 23. 

Task 5: Set the page size to 32 KB.

See Page Size on page 25.

Task 6: Enable the database for multipage file allocation.

See Enable the Database for Multipage File Allocation on page 25.

Task 7: Catalog the database.

See Catalog the Database on page 25.

A fully qualified DB2 administrator should assist with this preparation.
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Task 8: Set database codepage.

See Code Page Considerations on page 26.

Page Size

The default page size in DB2 is 4096 bytes (4 KB) Service Manager requires 
32768 byte (32 KB) pages. Be sure to create a 32 KB page size buffer pool, 
table space, and system temporary table space. Grant the login ID access to 
the new table spaces.

Enable the Database for Multipage File Allocation

Enabling multipage file allocation causes DB2 to allocate new data pages in a 
table space one multipage extent at a time rather than one page at a time, 
which reduces overhead of large insert operations. 

Follow these steps to enable multipage file allocation:

1 As the instance owner, disconnect all applications from the database.

2 Run the following command:

db2empfa <dbname>

Catalog the Database

Follow these steps to catalog the database:

1 Install the DB2 client on your Service Manager server.

2 Catalog the database you want to connect to by using the DB2 client 
utilities.

3 Use the name you defined when you performed the catalog operation as 
the database name for the configuration tool.

Enable multipage file allocation on SMS table spaces only. 
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Code Page Considerations

Create your DB2 database with a UTF-8 code page for use with Service 
Manager. All data passed from Service Manager to the RDBMS client is 
encoded in UTF-8, therefore using a UTF-8-based RDBMS will reduce 
overhead for converting data and prevent loss of special characters.

Microsoft SQL Server Preparation

This section provides details on the implementation of supported Microsoft 
SQL Server databases. It builds from the premise that Service Manager and 
Microsoft SQL server have already been installed. If the SQL server has not 
yet been installed, specify the desired case sensitivity for sort order during the 
creation of the database.

Complete the following procedures prior to the initial load of your database: 

Task 1: Allocate enough additional server connections for all your users.

See Server connections on page 22. 

Task 2: Create a login ID and password for Service Manager to use when it connects to your 
RDBMS server.

See Login ID on page 22. 

Task 3: If you plan to report on Service Manager data using RDBMS tools, set up time zones.

See Setting up time zones for RDBMS reporting on page 23.

Task 4: Tune server data for conversion. 

Task 5: Enable Truncate Log on Checkpoint for the target database.

See Limit the Transaction Log Size for Microsoft SQL Server on page 27. 

Task 6: Create an ODBC system data source.

A fully qualified Microsoft SQL server administrator should assist with this 
preparation.
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See Microsoft SQL Server Connectivity on page 27.

Task 7: Set desired case sensitivity.

See Set desired case sensitivity on page 28.

Task 8: Set the database codepage.

See Code Page Considerations on page 28.

Limit the Transaction Log Size for Microsoft SQL Server

During initial system load, Service Manager places a high insert transaction 
load on your SQL server. To prevent the transaction log from growing too 
large, set the Truncate Log On Checkpoint option for the target database on 
your SQL server.

Microsoft SQL Server Connectivity

General connectivity rules:

• The database name entered in the configuration tool must correspond to 
an ODBC system data source.

• Configure the ODBC data source as a System DSN. Set it up to use:

— SQL server authentication

— ANSI quoted identifiers

— ANSI nulls, paddings, and warnings

• Service Manager is compatible with 64-bit SQL Server 2005. 

— Service Manager will not work if you create the system DSN using a 
64-bit ODBC administrator.

— If your Service Manager is installed on a 64-bit Windows system, 
create the System DSN entry for the ODBC driver by launching 
odbcad32.exe from: C:\WINDOWS\SysWOW64.  
 
This creates a 32-bit SQL Native Client System DSN driver that 
Service Manager uses.
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• If your Service Manager is installed on a 32-bit Windows system, 
ServiceCenter uses the 32-bit SQL Native Client System DSN driver.

Set desired case sensitivity

Set the SQL Server database to the desired collation when you create it. If you 
want to run in case sensitive mode, pick a collation that ends with the 
following:

_BIN such as Latin1_General_BIN

If you want to run in case insensitive mode, pick a collation that ends with 
_CI_AS such as Latin1_General_CI_AS. Service Manager will automatically 
detect the settings and perform correctly.

Code Page Considerations

SQL Server does not support a UTF-8 code page. Choose a code page that 
supports most of your required characters. 

To use HP Service Manager in case insensitive mode, you must select a case 
insensitive collation on the SQL Server before installing HP Service Manager.

Oracle Server Preparation

Complete the following procedures prior to the initial load of your database:

Task 1: Allocate data space large enough to hold your data.

See General Space Requirements on page 22.

Task 2: Allocate enough additional server connections for all your users.

If you choose a Western European code page, the system cannot store Eastern 
European or Asian characters in columns defined as VCHAR, CHAR, or 
TEXT data type. If you have the need to store characters from different 
languages, consider using the NVARCHAR, NCHAR, or NTEXT data types 
instead.
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See Server connections on page 22. 

Task 3: Create a login ID and password for Service Manager to use when it connects to your 
RDBMS server.

See Login ID on page 22. 

Task 4: If you plan to report on Service Manager data using RDBMS tools, set up time zones.

See Setting up time zones for RDBMS reporting on page 23.

Task 5: Make sure that your tablespaces are set up properly.

See Set up Oracle tablespaces and users on page 30. 
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Task 6: Update the Unix environmental variable with the path to your Oracle 32-bit client 
libraries.

See Set the path to your Oracle 32-bit client libraries on page 31.

Task 7: Set the sqldb parameter.

See Set the sqldb parameter on page 31.

Task 8: Install an Oracle client on the Service Manager system.

See Set Up Oracle Connectivity on page 32.

Task 9: Set the database codepage

See Code Page Considerations on page 32.

Set up Oracle tablespaces and users

Most tables on an Oracle server hold less than 50 KB of data. Service Manager 
sets the initial storage space size when creating the SQL tables. 

When manually creating a new Oracle instance for Service Manager:

• Create the database with a block size of 8 KB or a multiple thereof. 

• Create a separate table space for the Service Manager data, and make this 
the default table space for the Service Manager user. 

• Set the TEMPORARY table space for the Service Manager user to an 
appropriate temporary table space.

A fully qualified Oracle administrator should assist with this preparation.
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Set the path to your Oracle 32-bit client libraries

Follow these steps to set your Unix environment variable for Oracle:

1 Find the path to your Oracle client’s 32-bit shared libraries.

2 Set the Unix environment variable as shown in the following examples. In 
these examples, the path to the Oracle client shared libraries is set 
relative to the Oracle environment variable $ORACLE_HOME.

C shell: setenv LD_LIBRARY_PATH $LD_LIBRARY_PATH: 
$ORACLE_HOME/lib32

Korn shell: export LD_LIBRARY_PATH=$LD_LIBRARY_PATH: 
$ORACLE_HOME/lib32

Set the sqldb parameter

The sqldb parameter in the sm.ini file specifies the name of the Oracle 
database connection. The connection name is defined in the tnsnames.ora file. 

• On Unix platforms, the tnsnames.ora file is located in $ORACLE_HOME/
network/admin or can be specified using the TNS_ADMIN environment 
variable.

• On Windows platforms, the tnsnames.ora file is located in the Oracle 
Home [%ORACLE_HOME%/network/admin] directory.
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Set Up Oracle Connectivity

Follow these steps to set up connectivity to your Oracle database:

1 Install the Oracle client on your Service Manager server.

2 Configure a connection to the Oracle server in the tnsnames.ora file.

3 In the configuration tool, name the database by using the name you 
provided in the tnsnames.ora file.

Code Page Considerations

Create your Oracle database with a UTF-8 code page for use with Service 
Manager. All data passed from Service Manager to the RDBMS client is 
encoded in UTF-8, therefore using a UTF-8-based RDBMS will reduce 
overhead for converting data and prevent loss of special characters.
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Installing the Sample Database

A copy of SQL Express is included on the installation DVD for demonstration 
purposes only. You will need an enterprise-level RDBMS for use in your 
development, test, and production systems. 

Follow these steps to install the sample database:

1 Log in to the Windows server as a user with local administrator privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

3 Click Install SQLServer2005 for use with HP Service Manager for testing 
purposes only.

The SQLServer folder opens.

4 Double-click SetupSQLServer.bat.

5 When prompted, press any key to exit the installation.

The sample database is now installed and has the following properties.

The out-of-box sm.cfg and sm.ini files are set up to work with this database. 
To connect a different database server, edit the configuration and 
initialization files for that server. 

Instance Name: SMDEMO

Security Mode: SQL

SA password: SM@7DEMODATA

Database Name: SMDEMO

Collation: Latin1_General_BIN
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3 Server Installation
You can install HP Service Manager on a Windows or Unix server. This section 
contains information about installation requirements and how to install the 
server. For information about starting and stopping servers, see the HP 
Service Manager online help.

Topics in this section include:

• Installing the server on Windows on page 36

• Installing the server on Unix on page 43

• Installing AutoPass on page 55

• Obtaining product licenses on page 58

• Configuring the server on page 65

Refer to the HP Service Manager Upgrade Guide for instructions on how to 
upgrade the server. 

For instructions on how to install the Knowledge Management search engine, 
see Search Engine Installation on page 119.

Before you can install the Service Manager server on AIX, HP-UX, and 
Solaris systems, you must install JVM 1.5. Refer to the Java documentation 
for instructions on how to install JVM. 
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Installing the server on Windows

For complete information about current platform requirements and 
compatibility, go to the Customer Support web site at the following URL:

http://support.openview.hp.com/

Installation requirements

• Compatible Windows operating system

• Current Windows updates for your operating system

• 1 GB RAM minimum recommended

— For production purposes, RAM is based on the expected user load.

• Local administrator account to install on the Windows server

For more information, see the Service Manager Compatibility 
Matrix. The HP Support matrices require that you register as an 
HP Passport user and sign in.

To register for an HP Passport ID, go to: 
http://h20229.www2.hp.com/passport-registration.html.

If you already have an HP Passport account, go to: 
http://support.openview.hp.com/sc/support_matrices.jsp.
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System requirements

Make sure that your system meets the following requirements before 
installing Service Manager.

Database resources

Service Manager requires the following relational database system (RDBMS) 
resources.

Table 1 Windows system requirements for server installation

Requirement Resources needed

Disk space 400 MB for server installation

TCP/IP 
service name

During the Service Manager server configuration, 
the system prompts you for a valid TCP/IP port. The 
port number you choose for Service Manager must be 
greater than 1024. 

Table 2 Database requirements for server installation

Requirement Resources needed

RDBMS server Install and configure a supported RDMS server:

• DB2
• Oracle
• SQL Server
See the Service Manager compatibility matrix for a 
list of currently supported RDBMS servers.

RDBMS client Install and configure a supported database client for 
your RDBMS server.

• DB2 client
• Oracle client
• Windows ODBC DSN defined for SQL Server
See the Service Manager compatibility matrix for a 
list of currently supported RDBMS clients.
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Server resources

The Service Manager server uses the following resources.

Table 3 Service Manager server system resources

Resource Definition

Processes The system starts one process for each sm command 
line in the sm.cfg file. By default, each process is 
limited to 50 concurrent user sessions. The system 
assigns each user session or background process a 
dedicated thread.
• If you start background processes by using the sm 

system start command in the sm.cfg file, then the 
sm processes own the background process threads. 

• If you start the background processes from a user 
session inside Service Manager, then the thread 
controller process that owns the user session also 
owns the background process threads.

To allow more than 50 concurrent user sessions, refer 
to the server implementation options topic in the help.

Shared Memory A server uses approximately 50 MB of base shared 
memory and requires an additional 5 MB of shared 
memory for every 50 users. 
You can specify the amount of shared memory the 
system allocates by using the shared_memory 
parameter in the sm.ini file.
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Service Manager server setup

Follow these steps to install the Service Manager server:

1 Log in to the Windows server as a user with local administrator privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

3 Click Install HP Service Manager Server for Windows.

4 Click Run to start the Service Manager Server setup wizard.

5 Click Next to read and accept the licensing agreement.

6 Select the I accept the terms in the License Agreement option.

The Next button becomes active.

7 Do one of the following:

• Click Next to accept the default installation folder.

The default installation folder is: 
C:\Program Files\HP\Service Manager 7.10\Server\

• Click Browse to choose a different installation location.

See the HP Service Manager 7.10 Upgrade Guide for more information 
about upgrading the server from previous versions.

8 Click Next to prepare the installation process.

The summary information page opens.

Do not install the server over existing versions of ServiceCenter or 
Service Manager. You must install into a new folder. 

The Service Manager server folder name cannot contain 
parentheses or use non-ASCII characters in the name. The server 
cannot start if installed in a folder with a non-compliant folder 
name.
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9 Click Install to begin copying the installation files.

You can stop the installation by clicking Cancel.

The Completing the Service Manager Server Setup wizard page opens 
when the installation is complete.

10 To automatically configure the server, select the Run the configuration 
program after install option.

11 Click Finish to exit the Setup wizard.

The server installation is complete.

If you selected the Run the configuration program after install option, the 
Configuring HP Service Manager Server wizard opens. Complete the steps 
in Configuring the server on page 65.

12 After the configuration steps are complete, close the browser window, or 
click the next item you want to install.

Uninstalling the Windows server

You can uninstall the server in one of two ways:

• Uninstall the server from Add/Remove Programs. See Uninstalling by 
using Add/Remove Programs on page 41.

• Uninstall the server from the Service Manager installation DVD. See 
Uninstalling by using the installation DVD on page 42.

The Autopass installation box opens and installs autopass 
automatically. Do not click Finish until the autopass installation is 
complete.

You can also configure the Service Manager server by editing the 
sm.ini configuration file. See Configuring the server on page 65.

The server uninstall process intentionally preserves server configuration 
settings and Service Manager data on your RDBMS. You must manually 
remove the configuration files and RDBMS data if you are completely 
uninstalling Service Manager from your system. HP recommends that you 
delete the entire server installation folder if you do not want to preserve any 
existing server data.
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Uninstalling by using Add/Remove Programs

Follow these steps to uninstall the server by using Add/Remove Programs:

1 Log in to the Windows server as a user with local administrator privileges.

2 Stop the Service Manager service.

For information about stopping the server, refer to the HP Service 
Manager online help.

3 From the Windows main menu, click Start > Settings > Control Panel > Add/
Remove Programs.

The Add/Remove Programs dialog box opens.

4 Scroll to the Service Manager server program and click Remove.

A message prompts you to verify that you want to remove the program.

5 Click Yes.

The process takes several minutes. Additional messages indicate the 
progress of the uninstall.

When you complete the uninstall, you return to the Add/Remove 
Programs dialog box.

6 Click Close.
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Uninstalling by using the installation DVD

Follow these steps to uninstall the server by using the installation DVD:

1 Log in to the Windows server as a user with local administrator privileges.

2 Stop the Service Manager service.

For information about stopping the server, refer to the HP Service 
Manager online help.

3 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

4 Click Install HP Service Manager Server for Windows.

The Service Manager Server setup wizard opens.

5 Click Next.

The Remove the Program window opens.

6 Click Remove.

The process takes several minutes. Additional messages indicate the 
progress of the uninstall. After the operation is complete, the InstallShield 
Wizard Completed page opens.

7 Click Finish.

8 Click Exit Install to close the DVD browser.
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Installing the server on Unix

For complete information about current platform requirements and 
compatibility, go to the Customer Support web site at the following URL:

http://support.openview.hp.com/

System requirements

Make sure that your system meets the following requirements before 
installing Service Manager.

Table 4 Unix system requirements for the server installation

Requirement Resources needed

Disk space 400 MB for server installation

Java Service Manager requires Java version 1.5 to be installed on the system. 
Either the JDK or JRE can be used and Service Manager will search for it 
at install time. Users running Linux on Intel x86 platforms do not need to 
install Java; Service Manager includes Java for that platform.

TCP/IP 
service name

During the Service Manager server configuration, the system prompts you 
for a valid TCP/IP port. The port number you choose for Service Manager 
must be greater than 1024. 

Service Manager will not run from a root account. You must create a separate 
user ID that owns Service Manager.
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Database resources

Service Manager requires the following relational database system (RDBMS) 
resources.

Table 5 Database requirements for server installation

Requirement Resources needed

RDBMS server Install and configure a supported RDMS server:

• DB2
• Oracle

RDBMS client Install and configure a supported database client for 
your RDBMS server.

• DB2 client
• Oracle client
44 Chapter 3



Server resources

The Service Manager server uses the following resources.

Other information

Review the following information before you install Service Manager. 

Table 6 Service Manager server system resources

Resource Definition

Processes The system starts one process for each sm command 
line in the sm.cfg file. By default, each process is 
limited to 50 concurrent user sessions. The system 
assigns each user session or background process a 
dedicated thread.
• If you start background processes by using the sm 

system start command in the sm.cfg file, then the 
sm processes own the background process threads. 

• If you start the background processes from a user 
session inside Service Manager, then the thread 
controller process that owns the user session also 
owns the background process threads.

To allow more than 50 concurrent user sessions, refer 
to the server implementation options topic in the help.

Semaphores Service Manager uses 11 semaphores, regardless of the 
number of users logged on to the system.

Shared Memory A server uses approximately 50 MB of base shared 
memory and requires an additional 5 MB of shared 
memory for every 50 users. 
You can specify the amount of shared memory the 
system allocates by using the shared_memory 
parameter in the sm.ini file. You should always 
allocate more shared memory in the operating system 
than what you specify for Service Manager in the 
sm.ini file. That is, your system needs more shared 
memory than what Service Manager requires to run.
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Table 7 Additional Unix requirements

Resource Requirement

ANSI Terminal If you want to run the installation from a console, run the 
installation script from an ANSI terminal to avoid 
rendering errors. Non-ANSI terminals such as hpterm 
may produce unreadable results.

Root Access You only need root access to modify the system kernel, 
mount the Service Manager DVD, and install AutoPass.
You must create a separate user ID to run Service 
Manager.
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Preliminary steps

Task 1: Determine the Service Manager installation path.

The user running the installation script must have permission to create new 
directories in the chosen installation path.

Task 2: Add the path to your 32-bit RDBMS client to the library path variable

Update your system’s library path variable to include the path to the 32-bit 
versions of your RDBMS client. You can add these directories as part of the 
shell login or as part of a profile script.

Refer to your operating system documentation for information on setting 
variables.

The following convention identifies variables that may change depending on 
your particular installation:

<variable>

As you go through the installation steps and see a variable in brackets, 
remember that you must replace the variable with information specific to 
your system. Do not type the brackets (< >) as part of the command.

Table 8 Path variables by operating system

OS Path variable to set

AIX LIBPATH

HP-UX SHLIB_PATH

Linux and Solaris LD_LIBRARY_PATH
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Installing the server

Follow these steps to install the Service Manager server:

1 Before installing the server, install AutoPass by following the instructions 
in Installing AutoPass on page 55.

2 Mount the DVD, and change directories to the mount location.

3 Run the executable script that matches your operating system. 

4 At the installation script prompt, you must Accept in order to proceed.

5 At the installation script prompt, type the installation directory address 
where you want to install Service Manager. 

Table 9 Setup scripts by operating system

OS Setup script

HP-UX on PA-RISC 
systems

setupHP11.bin

HP-UX on Itanium 
systems

setupHPIA64.bin

AIX setupaix

Solaris setupSolaris.bin

Linux setupLinuxX86.bin

The setup scripts assume you will run them from an X-Windows 
environment. If you prefer to run the scripts from a console instead, 
add “-console” to the command line. For example, to run the Solaris 
setup script from a console, type the following command.

setupSolaris.bin -console.

Do not install the server over existing versions of ServiceCenter or 
Service Manager. You must install into a new folder. 

The system validates any directory name that you specify. If you 
specify an invalid directory, the installation generates an error 
message.
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6 The system takes several minutes to read the contents of the DVD, 
uncompress the files, and complete the server installation in the specified 
directory. 

7 Click Finish to exit the Wizard.

8 To automatically configure the server, run the configure script, which is 
found in your <Install path>/directory to update the sm.cfg file. Go to 
Configuring the server on page 65 for instructions.

Uninstalling the Service Manager server

Follow these steps to uninstall the Service Manager server:

1 Stop the Service Manager server.

2 Delete all the Service Manager server directories and subdirectories.

Kernel resource requirements

The Service Manager server requires additional shared memory and 
semaphores to run. On most Unix systems, you can configure these resources 
through kernel configuration parameters. 

Do not use the "~" symbol when entering the path. InstallShield 
treats this as a regular character, and will create a directory with 
the name '~'.

You can also configure the Service Manager server by editing the 
sm.ini configuration file. See Configuring the server on page 65.

The following kernel resource requirements are the minimum values required 
to run a Service Manager server. If you are running other programs that 
require kernel resources on the same system as Service Manager, then add 
the Service Manager kernel resource requirements to the existing resources. 
For example, if the existing system requires 100 MB in kernel resources, and 
Service Manager requires an additional 50 MB, then update the kernel 
resources to 150 MB.
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AIX server

You do not need to manually adjust kernel resources on AIX systems because 
they are self-adjusting.

HP-UX server

Shared memory

Maxdsiz parameter

The HP-UX maxdsiz parameter sets the maximum data segment size for each 
process. This data segment can consist of virtual memory (swap space) and 
real memory. The system attempts to meet your requirements with real 
memory. It uses swap space to make up the difference until it reaches the 
maxdsiz limit.

Set maxdsiz to the maximum value. See your HP-UX help for information 
about setting this parameter.

Table 10 Shared Memory requirements

Kernel 
setting Value Remarks

shmem 1 Enables shared memory

shmmax Variable A server uses approximately 50 MB of base 
shared memory and requires an additional 5 
MB of shared memory for every 50 users. 
You can specify the amount of shared memory 
the system allocates by using the 
shared_memory parameter in the sm.ini file. 
You should always allocate more shared 
memory than what you specify in the sm.ini 
file.

shmmni Variable 1 semaphore ID per Service Manager system
50 Chapter 3



Setting kernel parameters

Use the SAM utility to configure kernel parameters on HP-UX.

To configure kernel IPC parameters:

1 Start SAM.

2 Select the Kernel Configuration option from the main menu.

3 Select the Configurable Parameters option.

4 Modify the kernel parameters as specified in Shared Memory 
requirements on page 50.

When you finish modifying the necessary parameters, the SAM utility guides 
you through the steps to restart the system. Restarting is necessary to 
activate the changes.

Linux server

Shared Memory

You must be a root user or have superuser capabilities before you start the 
SAM utility.

Table 11 Shared Memory requirements

Kernel 
setting Value Remarks

shmem 1 Enables shared memory

shmmax Variable A server uses approximately 50 MB of base 
shared memory and requires an additional 5 
MB of shared memory for every 50 users. 
You can specify the amount of shared memory 
the system allocates by using the 
shared_memory parameter in the sm.ini file. 
You should always allocate more shared 
memory than what you specify in the sm.ini 
file.

shmmni Variable 1 per Service Manager system
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Setting kernel parameters

The default shared memory limit (both SHMMAX and SHMALL) is 32 MB, 
but you can changed it from the proc file system without restarting the 
system. For example, to specify 128 MB:

You can use sysctl.conf to control these parameters. Add the following lines to 
the/etc/sysctl.conf file:

This file is usually processed at startup, but sysctl.conf can be called later.

Security

Before you start the Service Manager server, you must disable the Linux 
security feature, exec-shield-randomize. The out-of-box smstart script sends 
you an error message and does not start the server if exec-shield-randomize is 
on. However, if you use your own script instead of smstart, be aware that the 
server can start if exec-shield-randomize is turned on, but it will stop later.

The /proc/sys/kernel/exec-shield-randomize file controls whether Exec-Shield 
randomizes VM mapping. You can turn off exec-shield-randomize by using any 
of the following options:

• Use the following command:

The default value for /proc/sys/kernel/exec-shield-randomize is 1.

• Include the following line in the /etc/sysctl.conf file:

• Include the following line in the /etc/grub.conf file:

Solaris server

Shared memory

# echo 134217728 >/proc/sys/kernel/shmall
# echo 134217728 >/proc/sys/kernel/shmmax

kernel.shmall = 134217728
kernel.shmmax = 134217728

echo 0 >/proc/sys/kernel/exec-shield-randomize 

kernel.exec-shield-randomize=0

exec-shield=0
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Table 12 Shared Memory requirements

Kernel 
setting Value Remarks

forceload:sys/
shmsys

Enables shared memory

shmsys:shminfo 
_shmmax

Variable A server uses approximately 50 MB of 
base shared memory and requires an 
additional 5 MB of shared memory for 
every 50 users. 
You can specify the amount of shared 
memory the system allocates by using 
the shared_memory parameter in the 
sm.ini file. You should always allocate 
more shared memory than what you 
specify in the sm.ini file.

shmsys:shminfo 
_shmmni

Variable 1 per Service Manager system
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Number of file handles

The default upper limit for file descriptors is 256. You must increase this value 
to at least 512.

Follow these steps to increase the upper limit:

1 Log in to the Solaris server.

2 Run ulimit -a: 

To increase this value to 512, type the following command:

Setting kernel parameters

You can control kernel parameters with the /etc/system file. The operating 
system reads the /etc/system file at initialization time to define the initial 
kernel parameters. See your Solaris help for information on setting kernel 
parameters.

bash-3.00$ ulimit -a
core file size        (blocks, -c) unlimited
data seg size         (kbytes, -d) unlimited
file size             (blocks, -f) unlimited
open files                    (-n) 256
pipe size          (512 bytes, -p) 10
stack size            (kbytes, -s) 8192
cpu time             (seconds, -t) unlimited
max user processes            (-u) 29995
virtual memory        (kbytes, -v) unlimited

$ ulimit -n 512
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Installing AutoPass

Preparation

You must install the appropriate operating system patches before you can 
install AutoPass.

Solaris

32-Bit Shared library patch for C++ 

• Sun OS 5.9: Patch-ID# 111711-09

Installation

AutoPass installers for each operating system are included on the installation 
DVD. The AutoPass files are stored on the Service Manager DVD in the 
Server/Unix/autopass directory. 

Install the appropriate file from this location onto your system by using the 
normal software installation mechanism provided by your operating system.

HP-UX

Follow these steps to install AutoPass:

1 Run the following command as the root user:

swinstall -s <full-path-to-depot-filename>

On Windows platforms, AutoPass installs as part of the server installation. 
On Unix platforms, you must install it manually before you can run Service 
Manager. 

Make sure to use the appropriate .depot file for your version. 
IPF32 indicates Itanium, other HP-UX files are for PA-RISC.
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Solaris

Follow these steps to install AutoPass:

1 Run the following command as the root user:

pkgadd -d <full-path-to-pkg-filename>

Linux

Follow these steps to install AutoPass:

1 Run the following command as the root user:

rpm -Uhv <full-path-rpm-filename>

AIX

Follow these steps to install AutoPass:

1 Run the following command as the root user:

installp -a -d <full-path-to-bff-filename> HPOvLIC 

Make sure to use the appropriate .pkg file for your version.

Make sure to use the appropriate .rpm file for your version.

Make sure to use the appropriate .bff file for your version.

If you plan to turn on a 60-day temporary evaluation license on Unix, you 
must make LicFile.txt writable before running the sm -instantOn 
command. The default location for this file is: 

/var/opt/OV/HPOvLIC/LicFile.txt 

For more information, see Obtaining product licenses on page 58.
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Uninstalling AutoPass

AutoPass is not automatically uninstalled when Service Manager is removed. 

HP-UX

Run the following commands as root user to remove Autopass:

swremove HPOVLIC

Solaris

Run the following commands as root user to remove Autopass:

pkgrm HPOvLic

Linux

Run the following commands as root user to remove Autopass:

rpm -e HPOvLic

AIX

Run the following commands as root user to remove Autopass:

installp -u HPOvLIC

If you remove AutoPass, Service Manager and other applications that use 
AutoPass will no longer function.
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Obtaining product licenses

A license key password is required to use Service Manager. Licensing is 
managed with AutoPass. When the Service Manager software is installed and 
used for the first time, a 60-day trial license is granted (Instant-On). Within 
this 60-day period, you must obtain a perpetual license key password or a trial 
evaluation extension to continue using the product.  

After installing the server you can install a evaluation license by running the 
command  
sm -instantOn, which installs an evaluation license valid for 60 days. 

During the last ten days of the evaluation period, every user who wants to log 
in will see a license expiration warning message. The system administrator of 
the product must go to the Webware site (www.webware.hp.com) and 
download the perpetual license to use the product.

If you have not purchased all modules and you would like to consider adding 
some to review during the Instant-On process, please contact your HP account 
manager.

To request perpetual license passwords, you need the following items:

• Entitlement Certificate, which contains the HP product number and order 
number.

• IP address of the server.

• Your company or organization information.

The best way to obtain product licenses is through the web site: 

www.webware.hp.com 

On Windows platforms, AutoPass installs as part of the server installation. 
For a Unix platform, AutoPass must be installed manually. The instructions 
for installing AutoPass on Unix are provided in Installing AutoPass on 
page 55.

To run instantOn on Unix platforms, you must make LicFile.txt writable. 
For more information, see Saving your license key/password file to your 
system on page 63.
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You can also contact the HP Password Center by using fax, email, or phone. 
This information is available on the Password Request Form and the License 
Entitlement Certificate. In order to obtain product licenses, you need the 
License Entitlement Certificate.
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Using the web site

Follow these steps to obtain your product licenses:

1 Go to www.webware.hp.com.  
This links you to the web site - HP Password delivery service.

2 Select Generate password(s) on the Webware licensing menu.

3 Type your order number in the Order number text box. You order number is 
found on the License Entitlement Certificate - Password Request Form 
(HP Order Number).

4 Click Next.

5 Select the product you are requesting a password for on the Product 
selection form by clicking the check box for the product, and then click 
Next.

6 Select the product(s) for which you want to request password(s), and then 
click Next.

7 For each product you selected, type the number of Licenses  
To Use (LTUs) - limited by number of LTUs available for the order:

• Server host name

• IP address for the system where the software is installed

8 Click Next.

9 Provide all required information on the Member sign-in form, and then 
click Sign-In.

10 Provide all required information on the Address information form, and 
then click Next.

11 The Receive Permanent Password Certificate form displays a copy of your 
Permanent Password Certificate. It also offers additional delivery options 
for your certificate.
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You should also receive an email containing your password certificate(s) and 
license key/password file attachment(s) similar to the following example.
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To eliminate chances of error, it is highly recommended that license/
password(s) are installed directly from a license key/password file, rather than 
attempting to manually transcribe and edit them from the license/password 
certificate. Each license key/password file can be copied to the appropriate 
target system and then directly imported and installed by the application. No 
editing of the license key/password file is required.

Saving your license key/password file to your system

As part of the process of obtaining a permanent AutoPass license, a .dat file 
or several .dat files were sent to the email address that you provided. These 
files contain the licensing data required to use the applicable Service Manager 
modules. After you receive these files, you must move them to the Service 
Manager server.

Windows

Follow these steps to save your license key/password file to your system:

1 Rename the .dat file to a .txt file so that you can open it with a text 
editor.

Example: from J8888X1624204.dat to J8888X1624204.txt

2 Create a file, LicFile.txt, to store the license data in. The default 
location for this file is:

C:\Program Files\Common Files\Hewlett-Packard\HPOvLIC 
\data

3 Copy the license data from the license file and paste it in the 
LicFile.txt you created.

You need to create this file only once. If you request any additional 
licenses, you should append those licenses to the end of this file.
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Unix

Follow these steps to save your license key/password file to your system:

1 Rename the .dat file to a .txt file so that you can open it with a text 
editor.

Example: from J8888X1624204.dat to J8888X1624204.txt

2 Create a file, LicFile.txt, to store the license data in. The default 
location for this file is:

/var/opt/OV/HPOvLIC/LicFile.txt

Copy the license data from the license file and paste it in the 
LicFile.txt you created. 

3 Save the file LicFile.txt. 

This procedure must be performed by a user with root access.

You need to create this file only once. If you request any additional 
licenses, you should append those licenses to the end of this file.

If you plan to turn on a 60-day temporary evaluation license on Unix, you 
must make LicFile.txt writable before running the sm -instantOn 
command. The default location for this file is:  
/var/opt/OV/HPOvLIC/LicFile.txt 

For more information, see Obtaining product licenses on page 58.
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Configuring the server

You can customize your Windows and Unix server installation by modifying 
the HP Service Manager initialization file (sm.ini). 

You can define the processes the system starts automatically and the system’s 
startup parameters from the sm.cfg file. This file exists on both Windows 
and Unix systems.

• On Windows, sm.cfg determines how the system starts when started 
from a service.

• On Unix, sm.cfg determines how the system starts when started from 
the smstart script.

Configuration tool

If you selected the Run the configuration program after installation option, the 
configuration tool starts automatically during your installation. While this 
tool is intended to configure new or test implementations running the 
out-of-box sample data, you can use it whenever you want to change the 
settings in your system’s sm.ini file. 

See the Service Manager help for a complete list of the parameters stored in 
the sm.ini file.

The configuration tool overwrites your current sm.ini settings. You should 
back-up your system’s sm.ini file prior to running the configuration utility to 
prevent any accidental data loss or loss of service.
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Follow these steps to configure the server:

1 Run the Configure Server tool.

2 Specify the listener ports.

3 Specify the database type and connection information.

4 Verify the connection to confirm that Service Manager can connect to the 
database. 

5 Upload the demo data, if desired. 

Table 13 Listener Port Parameters

Parameter Default Description

HTTP Port 
(system)

13080 The communication port number to which 
you want Service Manager to listen to client 
connection requests.

Enable HTTPS 
Port

Select this option to enable an HTTPS port.

HTTPS Port The communication port number to which 
you want Service Manager to listen to 
secure client connection requests.

Table 14 Database type and connection information

Parameter Description

Database 
Type

The database you want to use to store your data.

SQL 
Database 
Name

• SQL server: the ODBC DSN name
• Oracle: the entry in tnsnames.ora
• DB2: the dbname

SQL User The user that Service Manager should connect to your 
Database with.

SQL 
Password

The password for the user that Service Manager should use 
to connect to your database with.
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Uploading the demo data also uploads the out-of-box 7.10 
applications. You will want to install these if you are not upgrading 
from ServiceCenter.
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Starting the server

You must start the server before users can access Service Manager. You can 
choose between several different implementation options to manage client 
connections to the server. The following is a list of the most common server 
implementation options:

• Horizontal scaling implementation

• Single servlet implementation

• Vertical scaling implementation

• Vertical scaling and required SSL implementation

For detailed information about selecting the implementation option that best 
meets your specific requirements, you must first install the Service Manager 
online help. For information about installing the online help, see Help Server 
Installation on page 99.
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4 Client Installation
You can only install an HP Service Manager Windows client on a Windows 
workstation. You can support clients running on other operating systems by 
installing the Service Manager web tier. This section contains information 
about installation requirements and how to install the Windows client.

Topics in this section include:

• Installing the Service Manager Windows Client on page 70

• Installing a Shared Service Manager Client on page 76

• Uninstalling the Service Manager Client or its Components on page 78
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Installing the Service Manager Windows Client

You must have local administrator privileges to install the Service Manager 
client. 

The Windows client requires that the workspace and configuration folders are 
writable. By default, the client workspace and configuration information is 
stored in the following directory:  
C:\Documents and Settings\user_name\Service Manager

Upgrading the Windows Client

You cannot upgrade previous Service Manager clients to the Service Manager 
7.10 Windows client. You must install the Service Manager 7.10 Windows 
client in a new folder. HP recommends but does not require that you remove 
previous Service Manager clients.

Make a backup of any customized Help files you have created for your Service 
Manager clients. The installer for the Service Manager 7.10 Windows client 
overwrites any customized help from prior clients.
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Installation Requirements

Service Manager Client Setup

Follow these steps to install the Service Manager Windows client:

1 Log in to the Windows server as a user with local administrator privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

3 Click Install Windows Client. The Service Manager Client Setup wizard 
opens.

4 Click Next to read and accept the licensing agreement.

Table 1 Windows client installation requirements

Requirement Minimum Recommended

OS Windows 2000 Windows XP Professional or Vista (SP1 
or higher)

CPU Pentium III 650Mhz Pentium IV or Celeron 2.4 Ghz

RAM 256 MB 384 MB

HD 150 MB Help Server installed 150 MB with Help Server installed
300 MB with documentation installed

Resolution 800 x 600 (16 colors) 1280 x 1024 (256 colors)

Network 100 Megabit 100+ Megabit

Login account Local administrator account Local administrator account

The Service Manager Windows client setup displays in the same language as 
the operating system.
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5 Select the I accept the terms in the License Agreement option.

The Next button becomes active. The Select Installation Folder page opens.

6 Do one of the following:

a Click Next to accept the default installation folder.

The default installation folder is: 
C:\Program Files\HP\Service Manager 7.10\Client

b Click Browse to choose a different installation location.

7 Click Next to select the client features you would like to install. 

8 Click Next to prepare the installation process. The Summary page opens.

9 Click Install to begin copying the installation files. You can stop the 
installation by clicking Cancel.

The Completing the Service Manager Client Setup wizard opens when the 
installation is complete.

10 Click Finish to exit the Setup wizard. The client installation is complete. 

11 Close the browser window, or click the next item you want to install.

Defining a New Client Connection

The first time you access the client, the Connections window opens, which 
enables you to define a connection to a Service Manager host server. You can 
add and save multiple connection settings from the Connections window.

You must set your connection to an active server process. By default, the 
following are the defined settings: 

• Client listener on ports 13080 (http) and 13443 (https/SSL) for HTTP 
clients, including Windows, web, and SOAP-API

• Special listener on port 12690 for SCAuto

If your server setup does not use the default settings, you must set the client 
to connect to the server.
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Define a new client connection

Follow these steps to define a new client connection:

1 From the Windows main menu, click Start > Programs >  HP > Service 
Manager 7.10 > Service Manager Client. The Connections window opens.

2 Click New. The Connections window displays a new node in the 
Connections pane.

3 Type or select the connection parameters.

Table 2 Windows client connection parameters

Parameter Default option Description

Name New_configuration The name of this configuration.

User name User name of the 
Windows user 
currently logged on.

The name that you use to log in to the server.

Password blank The password that you use to log in to the 
server.

Remember my 
password

False An option for the system store your password.

Automatically login False An option to log in automatically when you 
start the Service Manager client.

Server host name localhost The name of the server that hosts the Service 
Manager service.

Server port number 13080 The port number that your computer uses to 
connect with the server.

Language blank The language to use for this session (can differ 
from the language set on the computer).

Connection identified 
by a color

blank An option to change the background color of 
your connection.
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4 Click Advanced to set other connection options. The advanced features are 
optional.

5 Click OK to add advanced features.

6 Click Apply to add the connection.

7 To add additional connections, repeat step 2 through step 6.

Table 3 Windows client advanced connection parameters

Parameter Description

Compress  
SOAP messages

An option that compresses SOAP messages using GNU zip (gzip) 
encoding. This can reduce the amount of data transmittal to and from the 
server.

Use SSL  
Encryption

An option that uses a Secure Socket Layer (SSL) encryption tool to protect 
your data when transmitting it over the network.

Trace SOAP  
traffic

An option that logs SOAP messages for debugging.

You must define a valid CA certificates file to enable SSL 
encryption. A sample CA certificate file called cacerts is included 
with the client installation. The default location of the cacerts file 
for a windows installation is: 
C:\Program Files\HP\Service Manager 7.10\Client\ 
plugins\com.hp.ov.sm.client.common_7.10

For additional information about configuring the Windows client, 
see the Service Manager Help.
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Connecting to a Service Manager server

You can connect to multiple servers from one Service Manager client. Each 
connection opens in its own window.

Follow these steps to connect to a Service Manager server:

1 From the Windows main menu, click Start > Programs > Service Manager 
Client > Service Manager Client.

The Connections window opens.

2 Do one of the following:

• Double-click a connection.

• Click a connection and then click Connect.
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Installing a Shared Service Manager Client

You can install the Service Manager client on a network share and have 
multiple users run from the shared client installation. In a shared client 
configuration, you can configure each user to have individual local settings or 
require users to use common settings. The Service Manager server tracks each 
client connection separately regardless of its source. Follow these steps to 
install a shared instance of the Service Manager client:

1 Install the Service Manager client on a network server. For more 
information, see Installing the Service Manager Windows Client on 
page 70.

2 Create a Windows network share to the folder where you installed the 
Service Manager client, and grant users access to the network share. For 
example:

\\my_server\Service Manager Client

For more information, refer to the Windows online help. 

3 Log in to the computer system of each user who will use the shared client.

4 Map the network share to a drive letter on the local system. For example: 
 
Drive letter: F: 
Mapped to: \\my_server\Service Manager Client

5 Create a Windows shortcut to the ServiceManager.exe file in the 
network share. For example: F:\ServiceManager.exe

By default, all users share common client settings. If you want each user 
to have individual local client settings, continue to the next step.

6 Modify the target properties of the Windows shortcut to add the following 
information after the executable name: -data 
%USERPROFILE%\Service Manager\

The -data parameter allows you to specify a path where you want to store 
client settings. The example path above places a Service Manager folder 
in the Document and Settings folder of the currently logged in user.
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If your path name includes spaces, you must enclose the path in 
double quotation marks. For example:

F:\ServiceManager.exe -data "%USERPROFILE%\HP 
Service Manager\workspace"
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Uninstalling the Service Manager Client or its 
Components

You can uninstall the Service Manager client using Windows Add/Remove 
Programs.

Follow these steps to uninstall the Service Manager client or components:

1 From the Windows main menu, click Start > Settings > Control Panel > Add/
Remove Programs.

The Add/Remove Programs window opens.

2 Scroll to Service Manager Client and click Remove.

A message prompts you to verify that you want to remove the program.

3 Click Yes.

The uninstall process takes several minutes. Additional messages indicate 
the progress of the uninstall.

When you complete the uninstall, you return to the Add/Remove 
Programs dialog box.

4 Click Close.

The client uninstall process intentionally preserves your client 
configuration settings. You must manually remove these files if you 
are completely uninstalling Service Manager from your system. HP 
recommends that you delete the entire client installation folder and 
the local writable workspace and configuration folder if you do not 
want to preserve any existing client settings.
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5 Web Tier Installation
The web tier installation allows clients to use a web interface to access the  
HP Service Manager server.

Topics in this section include:

• Web Tier Architecture on page 80

• Browser Requirements for the Web Client on page 81

• Installing the Web Tier on page 82

• Accessing Service Manager from the Web Client on page 93

• Web Client Computer Telephony Integration (CTI) on page 94

• Using the Telephony Web Client on page 97
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Web Tier Architecture

The Service Manager web tier uses both a web server and a web application 
server to allow access to Service Manager forms through a web browser. The 
web server handles incoming HTTP requests while the web application server 
runs the Java and JSP necessary for connecting to Service Manager.

You install the web tier on Windows or Unix platforms by deploying the 
webtier-7.10.war file to your web application server. Some web application 
servers also require you install the Sun J2SE Java Development Kit (JDK).

Some web application servers such as Tomcat and WebSphere include built-in 
web servers.
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Browser Requirements for the Web Client

In order for users to access the web client through a browser, the following 
settings and options must be enabled:

• Enable Cookies

• Enable Java

• Enable JavaScript

• Enable pop-ups. You can add the Service Manager server URL to the 
pop-up exception list.

To display the workflow graphical view, install one of the following Java 
components:

Table 1 Web client browser requirements

Operating System Java component to install

Windows XP One of the following:
• Microsoft Java Virtual Machine (JVM) 

plug-in
• Sun Java Runtime Environment (JRE) 

All other operating systems Sun Java Runtime Environment (JRE)
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Installing the Web Tier

To install the Service Manager web tier you must complete the following 
tasks:

Task 1: Determine the web architecture needed to support your web tier.

See Determining the web architecture needed to support your web tier on 
page 83.

Task 2: Deploy the Service Manager web tier to your web application server.

See Deploying the Service Manager Web Tier on page 84.

Task 3: Install endorsed JAR files if needed by your web application server.

See Installing Endorsed JAR Files on page 90.

Task 4: Set your web application server memory settings for your production environment.

See Setting the Web Application Server Heap Size on page 91.

Task 5: Set global web client preferences in the web.xml file

See Setting web client preferences from the web.xml configuration file on 
page 87.
82 Chapter 5



Determining the web architecture needed to support your web tier

A Service Manager web tier requires at least one web application server to 
run. Depending on the features and scale of your web tier, it may also require 
a dedicated production web server and additional web application servers. 
Refer to the guidelines below to determine the number of web application 
servers and web servers your implementation requires.

Determining if the web tier requires a dedicated production web server

If you use any of the implementation options list below, you will need to install 
and configure a dedicated production web server. If you are not running any of 
the configurations listed below, then you can run your web tier from a single 
web application server.

• A trusted sign-on implementation (You want web client users to log in to 
Service Manager without entering a user name and password.)

• A load balanced implementation (You want to distribute web client 
connections among multiple web application servers.)

• A scaled implementation to support a large number of concurrent users 
(You want to support 300 or more concurrent web client connections.)

Trusted sign-on implementations

A trusted sign-on implementation requires a web server to accept the 
pre-authenticated HTTP header information from your authentication 
software (such as SiteMinder or Integrated Windows Authentication). You 
must install and configure the authentication software separately. See your 
web server documentation for information about the HTML headers that your 
web server expects from your authentication software. For additional 
information, search the HP Support site for the following white papers:

Trusted Sign-On Authentication in ServiceCenter 6.1 and Greater Versions

Integrating ServiceCenter with Third-Party Authentication Tools
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Load balanced implementations

A load balanced implementation uses a web server to route connection 
requests to two or more web application servers. You must configure the web 
server to identify the web application servers (also known as workers) that are 
available to accept web client requests. For some web server and web 
application server combinations, you may need to install additional connection 
software (for example, to route requests to Tomcat web application servers 
using the Apache web server, you must install the proper connector). See your 
web server and web application server documentation for information about 
routing HTTP requests to available worker web application servers.

Scaled implementations

A scaled implementation uses the load balanced implementation described 
above to support a large number of concurrent web client users. As a general 
rule, HP recommends starting one worker web application server for every 
300 concurrent web client connections you want your web tier to support. To 
help determine the number of connections your web tier can support, search 
the HP Support site for the following white paper:

Service Manager 7 Reference Configurations

Deploying the Service Manager Web Tier

The Service Manager web tier contains a J2EE-compliant web application 
that runs on your web application server. Each web application server has its 
own method of deploying web applications. See your web application server 
documentation for specific instructions on deploying a web application.
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The following table provides a summary of deployment methods required.

Deploy the web tier on Tomcat

For example, use the following steps to deploy the webtier-7.10.war file on 
Tomcat.

1 Log in to the server as a user with local administrator privileges.

2 Stop the Tomcat Web application server.

3 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

4 Click Download Service Manager Web Tier. The File Download prompt opens.

5 Click Save. The Save As dialog box opens.

6 Save the file to your Tomcat webapps directory. For example, C:\Program 
Files\Apache Software Foundation\Tomcat 5.0\webapps)

7 Edit the web.xml file within the webtier-7.10 file to add your server 
connection information. See Setting web client preferences from the 
web.xml configuration file on page 87.

Table 2 Web tier deployment methods

Web application 
server Deployment method

Apache Tomcat Copy the webtier-7.10.war file to the webapps 
folder and start the web application server.

BEA WebLogic Open the administration console and install the web 
application from the webtier-7.10.war file.

IBM WebSphere Open the administration console and install the web 
application from the webtier-7.10.war file.
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You can also set your web client preference after you deploy the web 
tier. You can deploy the web tier without setting web client 
preferences, but the web tier will not accept client connections until 
you set them.
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Setting web client preferences from the web.xml configuration file

You can define global web client preferences from the web.xml file on the web 
tier server. The settings you define in this file determine the client preferences 
for all web clients. See the Service Manager online help for a complete list and 
more detailed explanation of each parameter.

Follow these steps to set client preferences from the web.xml file:

1 Open the webtier-7.10.war file in an archive management program.

You can download these files from the Service Manager installation DVD.

2 Extract the web.xml file from the archive to your local system.

3 Open the web.xml file in a text editor.

4 Add or edit the preferences in the file. For a list of the most commonly set 
web parameters, see Commonly Set Web Parameters on page 89.

Extract this file into its default path of WEB-INF\ so that you can 
preserve the path information when you archive it again.
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5 At a minimum, you must set the serverHost and serverPort parameters.

6 Save the file.

7 Start the Tomcat server.

Tomcat automatically opens the webtier-7.10.war file and creates a 
webtier-7.10 virtual directory. 

8 Add the updated web.xml file back into the webtier-7.10.war archive.

Web clients will now use the client preferences you defined in the 
web.xml file when you deploy the webtier-7.10.war to the web tier.

<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE web-app PUBLIC "-//Sun Microsystems, 
Inc.//DTD Web Application 2.2//EN" "http://
java.sun.com/j2ee/dtds/web-app_2_2.dtd">

<web-app>

<display-name>Service Manager</display-name>

<description>Service Manager</description>

...

<init-param>

<param-name>serverHost</param-name>

<param-value>localhost</param-value>

</init-param>

<init-param>

<param-name>serverPort</param-name>

<param-value>13080</param-value>

</init-param>

...

Set the host

Set the port

If Tomcat does not create a webtier-7.10 directory when started, check the log 
files and contact support with the information found in the log files.

The web.xml file must include the WEB-INF\ path.
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Web Tier Log Files

The Service Manager web tier writes log files to the default log file and 
location used by your web application server. See your web application server 
documentation for the name and location of the log file.

Commonly Set Web Parameters

Table 3 Commonly set web tier parameters 

Parameter
Default  
value Description

cacerts WEB-INF This parameter lists the path to the CA certificates required 
for SSL support.

compress_soap false This parameter specifies if you want to use data compression 
between web clients and the Service Manager web tier.

helpServerHost localhost This parameter specifies the name of the Service Manager 
Help Server.

helpServerPort 80 This parameter specifies the communications port number 
to which the Service Manager Help Server listens.

refreshMessages false This parameter determines whether the browser checks for 
new messages from the application server.

refresh 
MessagesInterval

15000 This parameter determines how often (in milliseconds) the 
browser checks for new messages from the application 
server.

serverHost localhost This parameter specifies the name of the Service Manager 
host server.

serverPort 13080 This parameter specifies the communications port number 
to which the Service Manager server listens.

ssl false This parameter enables the web client to encrypt 
communications using the server’s demonstration 
certificate.

viewactivenotes false This parameter determines whether you see a pop-up 
message when the server sends a message. 
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Installing Endorsed JAR Files

Depending on the web application server you use, you may need to install 
several endorsed JAR files to allow the Service Manager web tier to function 
properly. These files enable certain features such as SOAP over HTTP and 
Fast Infoset encoding. 

This table lists the requirements for endorsed JAR files by each supported 
web application server.

The required JAR files include:

• dom-jwsdp-1.6.jar 

• jai_imageio-1.0.jar 

• jaxp-api-jwsdp-1.6.jar 

• sax-jwsdp-1.6.jar 

• xalan-jwsdp-1.6.jar 

• xercesImpl-jwsdp-1.6.jar

Table 4 Web application servers that require endorsed JAR files

Web application  
server

Install 
endorsed 
JAR files? Place in

Apache Tomcat Yes $TOMCAT_HOME/common/endorsed

IBM WebSphere Yes $WAS_HOME/java/jre/lib/endorsed

BEA WebLogic No n/a
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Install endorsed JAR files

Follow these steps to install the endorsed JAR files:

1 Copy all JAR files from the following folder of the Service Manager 
installation DVD: 

Redistributables\Java\Endorsed

2 Add the files to the endorsed folder of your web application server. 

Make sure to replace any files currently in the endorsed folder with the 
files from the Service Manager installation DVD.

Setting the Web Application Server Heap Size

The web application server heap size directly determines how many 
connections each web application server can handle. Most application servers 
require a heap size of at least 256 MB for optimal performance. If you 
experience poor performance from your web client connections, try increasing 
the web application server heap size. See your web application server 
documentation for instructions on setting the heap size.

If you do not already have an endorsed folder for your web 
application server, you must create one to install the endorsed JAR 
files.
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Configuring the Web Server to Work with Service Manager

IIS

Edit the workers.properties.minimal (IIS 5) or workers2.properties (IIS 6.2) 
file to include the following 5 parameters:

[uri:/sm/servlet/*] 
info=Prefix mapping

[uri:/sm/*.jsp] 
info=Extension mapping

[uri:/sm/*.do] 
info=Extension mapping

[uri:/sm/attachments/*] 
info=Extension mapping

[uri:/sm/cwc/nav.menu] 
info=Extension mapping
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Accessing Service Manager from the Web Client

Use the following URLs to access the Service Manager from the web tier.

• The address for the standard web client is:

http://<server>:<port>/webtier-7.10/index.do

The address for employee self-service web client is:

http://<server>:<port>/webtier-7.10/ess.do

The address for the accessible web client is:

http://<server>:<port>/webtier-7.10/accessible.do

The accessible web client does not display record lists.

The address for the accessible employee self-service web client is:

http://<server>:<port>/webtier-7.10/accessible_ess.do

For <server>, type the name of the web server running the web tier. For 
<port>, type the communications port number used to connect to the web tier.

You do not need to specify the communications port in the web tier URL if you 
use the default web server port (port 80). See your web server documentation 
for instructions on setting the communications port.
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Web Client Computer Telephony Integration (CTI)

The web client can support connections from Computer Telephony Integration 
(CTI) applications. The Web client CTI implementation uses the Service 
Manager Event Services application to open or update records.

Follow these steps to set up and use CTI:

Task 1: Set up your web browser. 

See Setting the Web Browser Requirements on page 94.

Task 2: Install a JRE. 

See Installing the JRE on page 95.

Task 3: Install the CTI applet.

See Installing the CTI Applet on page 96.

Task 4: Connect to the web client to receive calls.

See Taking a Call with the Telephony Web Client on page 97.

Setting the Web Browser Requirements

Enable the following settings and options to use CTI with a web client:

• Cookies

• Java

• JavaScript

• Pop-ups. (Add the Service Manager server URL to the pop-up exception 
list.)
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Installing the JRE

You must install a Java Runtime Environment (JRE) on each web client 
system to run the CTI applet. See your Web browser documentation to 
determine a compatible JRE version.

For example, you can follow these steps to install the Sun J2SE JRE, which 
you can use with Internet Explorer or Mozilla:

1 Go to Sun java web site: http://java.sun.com/javase/downloads/
index.jsp.

2 Find the Java Runtime Environment (JRE) section, and click Download.

3 Accept the license agreement.

4 Navigate to your operating system (for example, Windows), and download 
the latest JRE for your operating system.

Table 5 Browser JRE requirements for CTI support

Operating System Java component to install

Windows XP One of the following:
• Microsoft Java Virtual Machine (JVM) plug-in
• Sun Java Runtime Environment (JRE) 

Other operating 
systems

Sun Java Runtime Environment (JRE)
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Installing the CTI Applet

You must perform a one-time installation of the CTI applet on each web client 
system so the web client can accept Service Manager system events from a 
CTI application.

Follow these steps to install the CTI applet:

1 Log in to the web client system with a local administrator account.

2 Close all other Service Manager clients and web browser windows.

3 Open a web browser and navigate to the telephony web tier URL:

http://<server>:<port>/sc/index.do?telephonyuser=1

For <server>, type the name of the web server running the web tier. For 
<port>, type the communications port number used to connect to the web 
tier.

4 If the web client system has a properly installed JRE, then the web 
browser prompts the user to install the CTI applet:

5 Click the appropriate action on your browser to accept the applet (for 
example, Run or OK).

6 Close and restart the web browser.

The applet installation requires a local administrator account.
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Using the Telephony Web Client

The telephony web client requires a CTI application and the Event Services 
application within Service Manager.

Accessing CTI from the Web Client

You can use the following URLs to access the telephony portions of the web 
client.

• The address for the standard telephony web client is:

http://<server>:<port>/sm/index.do?telephonyuser=1

• The address for the accessible telephony web client is:

http://<server>:<port>/sm/accessible.do?telephonyuser=1

This address turns off record list mode and the classic menu, which do not 
conform to accessibility requirements.

For <server>, type the name of the web server running the web tier. For 
<port>, type the communications port number used to connect to the web tier.

Taking a Call with the Telephony Web Client

When an event comes from a CTI application, the telephony web client 
prompts users to save their current work. 

The telephony applet does not apply to the self-service portions of Service 
Manager.

You do not need to specify the communications port in the web tier URL if you 
use the default web server port (port 80). see your web server documentation 
for instructions on setting the communications port.

Save your current work, and then click Yes to receive the incoming call (or 
other event).
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6 Help Server Installation
You must install the HP Service Manager Help Server on a Windows system. 
This section contains information about installation requirements and how to 
install the Help Server. For information about starting and stopping the Help 
Server, see Accessing the Help Server on page 105.

Topics in this section include:

• Overview of the Service Manager Help Server on page 100

• Installing the Help Server on Windows on page 102

• Accessing the Help Server on page 105
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Overview of the Service Manager Help Server

The Service Manager Help Server provides a centralized location to access 
and store all online help files. The Service Manager Help Server includes an 
integrated web server that allows end users to access documentation from 
either the Windows or web clients as well as directly from a web browser.

Upgrading the Help Server

You cannot upgrade previous Help Servers to the Service Manager 7.10 Help 
Server. You must install the Service Manager 7.10 Help Server in a new folder 
or on a different system than your previous Help Server. HP recommends that 
you remove previous Help Servers, but it is not required.

Installation Considerations

Installing the Service Manager Help Server enables you to:

• Provide your users with an easily updatable help source.

• Deploy tailored versions of Service Manager documentation. You can edit 
the online help stored on the Help Server and deploy it with the integrated 
web server. All clients that connect to the Help Server automatically see 
the customized online help files.

Make a backup of any customized Help files you have created for your Help 
Servers. The installer for the Service Manager 7.10 Help Server overwrites 
any customized help from prior Help Servers.
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Known Issues

The Service Manager Help Server has the following known issues:

• The Help Server can only deploy documentation in the existing plug-ins. 
You must add or edit topics in the existing plug-ins.

To test the Help Server from the server machine, use a direct browser 
connection to:

http://<helpserverhost>:<helpserverport>/help/

For <helpserverhost>, type the name or IP address of the Help Server you 
want to connect to.

For <helpserverport>, type the communications port used to connect to the 
Help Server. You may omit the port number if you use the default port 80 
HTML port.
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Installing the Help Server on Windows

After installing the Help Server, you can customize the server settings in the 
Help Server Configuration wizard.

Installation Requirements

• Windows 2000 or Windows 2003

• The most current Windows updates on your operating system

• 240 MB disk space

• 256 MB RAM minimum recommended

— For testing purposes, 128 MB RAM is sufficient
— For production purposes, RAM is based on the expected user load

• A free communications port to listen for HTTP connections requests. The 
default communications port is 8083.

• One of the following Java components:

Table 1 Help server installation requirements

Operating system Java component to install

Windows XP One of the following:
• Microsoft Java Virtual Machine (JVM) plug-in
• Sun Java Runtime Environment (JRE) 

All other OS Sun Java Runtime Environment (JRE)
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Service Manager Help Server Setup

Follow these steps to install the Service Manager Help Server:

1 Log in to the Windows server as a user with local administrator privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

3 Click Install HP Service Manager Help Server. The Service Manager Help 
Server Setup wizard opens.

4 Click Next to read and accept the licensing agreement.

5 Select the I accept the terms in the License Agreement option. The Next 
button becomes active.

6 Click Next to continue. The Select Installation Folder page opens.

7 Type or select the path where you want to install the Help Server, and 
then click Next to continue. The Ready to Install page opens.

8 Click Install. The wizard installs the Help Server on the system.

9 Click Finish. The Configure HP Help Server wizard closes.

10 Click Start > All Programs > HP > Service Manager 7.10 > HelpServer > 
Configure Help Server. The Service Manager Help Server Configuration 
page opens.

11 Click Next.
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12 Do one of the following:

a Click Skip to use the default configuration settings.

b Update the following parameters as needed.

13 Click Next to continue.

The Service Manager Help Server Configuration page opens.

14 Select the Install Windows Service option.

15 Click Finish.

The wizard configures the Help Server and installs the Windows service.

Table 2 Help server configuration parameters

Parameter
Default 
value Description

Server port 8083 This parameter specifies the 
communications port to which you want the 
Help Server to listen for HTTP requests.

Windows 
Service  
Name

HP Service 
Manager 
7.10 Help 
Server

This parameter specifies the name of the 
Windows service you want the Help Server 
to use.
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Accessing the Help Server

You can access the Help Server from the following interfaces:

• Windows client, see Accessing the Help Server from the Windows Client 
on page 105

• Web client, see Accessing the Help Server from the Web Client on 
page 106

• Web browser, see Accessing the Help Server from a Browser on page 106

Accessing the Help Server from the Windows Client

To have Windows clients display online help from the Help Server, you must 
configure the Windows client preferences and define the Help Server host 
name and communications port. 

Follow these steps to configure a Windows client to display online help from 
the Help Server:

1 Log in to the Windows client.

2 Click Window > Preferences.

The Preferences window opens.

3 Click the Help node to expand it.

4 Click Help Server.

5 Enable the Use a Help Server to access documentation option.

6 Type the following information:

a Host name or IP address of the Help Server

b Communication port of the Help Server

7 Click OK.

The Windows client now displays the online help from the Help Server 
when the user clicks the Help icon or select Help > Help Contents.

This setting is saved with your client preferences and is captured by the 
Client Configuration utility so that you can easily deploy it to your Windows 
client users.
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Accessing the Help Server from the Web Client

By default, web clients do not display online help. To have web clients display 
online help from the Help Server, you must configure the web client web.xml 
file and define the Help Server host name and communications port.

Follow these steps to configure a web client to display online help from the 
Help Server:

1 Log in to the server where you installed the web tier.

2 Open the web.xml file from the sm/WEB-INF folder of your application 
server installation.

3 Type the following information:

a helpServerHost - Host name or IP address of the Help Server

b helpServerPort - Communication port of the Help Server

4 Save the web.xml file.

The web client displays the online help from the Help Server.

Accessing the Help Server from a Browser

You can view the online help from a Help Server by typing the following URL 
into a compatible web browser:

http://<helpserverhost>:<helpserverport>/help/

For <helpserverhost>, type the name or IP address of the Help Server you 
want to connect to.

For <helpserverport>, type the communications port used to connect to the 
Help Server. You may omit the port number if you use the default port 80 
HTML port.
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7 Client Configuration Utility Installation
You can install the Service Manager Client Configuration Utility on a 
Windows system. This section contains information about installation 
requirements and how to install the Client Configuration Utility.

Topics in this section include:

• Overview of the Service Manager Client Configuration Utility on page 108

• Installing the Client Configuration Utility on Windows on page 110

• Customizing Images Used by the Windows Client on page 112

• Customizing the Windows Client on page 114
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Overview of the Service Manager Client Configuration 
Utility

The Service Manager Client Configuration Utility is an optional tailoring 
component that enables you to customize a Windows installation for deploying 
to end users. You can use the Client Configuration Utility to customize the 
Windows client before deploying it to the rest of your organization.

The Client Configuration Utility cannot push customizations changes to 
previously installed Windows clients. To change existing installations of the 
Windows client, you uninstall the existing client and reinstall using the 
customized files you create. 

The Client Configuration Utility only picks up changes made directly from the 
Windows client interface or within the utility itself. The Client Configuration 
Utility cannot pick up changes made directly to Windows client initialization 
files.

The Service Manager Client Configuration Utility changes the following 
Windows client settings:

• Splash screen image that Service Manager displays when users open the 
Windows client

• Name of provider listed for Service Manager — for example, 
Hewlett-Packard Development Company, L.P.

• Name of the Service Manager application - for example, Service Manager

• Location of application images and icons

• Location of the Help Server where Windows clients can access 
documentation

• Changes that an administrator saves within the Windows client interface 
prior to running the Client Configuration Utility, including:

— Default login options

— Connection dialog box configuration options to display

— Default connection configuration settings

— Help server configuration options
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Installation Considerations

You may want to use the Service Manager Client Configuration Utility for the 
following reasons:

• To deploy tailored versions of Windows clients. You can use the Client 
Configuration Utility to preconfigure Windows clients to use custom 
settings and images.

• To reduce the number of tailoring steps. When you use the Client 
Configuration Utility you are not required to tailor each Windows client 
individually.

Known Issues

The Service Manager Client Configuration Utility has the following known 
issues:

• You must customize images before you run the Client Configuration 
Utility. The Client Configuration Utility enables you to change the 
location of images but not to edit them directly.

• If you deploy a repackaged Windows client that has a predefined 
connection over SSL, then the Windows clients may display the connection 
error message “No trusted certificate found” if users install the 
customized client in a different path than the original client install. You 
can restore the client connection by providing the correct path to the CA 
certificate file in the client Preferences dialog box. 
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Installing the Client Configuration Utility on Windows

You install the Client Configuration Utility by running the installation 
executable on the installation DVD. After installation, you can customize the 
Windows client settings by using the Client Configuration Utility.

Installation Requirements

• Windows 2000, Windows XP Professional or Windows Vista

• The most current Windows updates on your operating system

• 70 MB disk space

• 256 MB RAM minimum recommended

— For testing purposes, 128 MB RAM is sufficient

— For production purposes, add RAM to match the expected user load

• Access to a Service Manager Windows client installation

Service Manager Client Configuration Utility Setup

Follow these steps to install the Service Manager Client Configuration Utility:

1 Log in to the Windows system as a user with local administrator 
privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

3 Click the Downloads tab.

4 Click Download the HP Service Manager Client-Configuration utilities.

The Service Manager Client Configuration Utility Setup wizard opens.
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5 Click Next to read and accept the licensing agreement.

6 Select the I accept the terms in the License Agreement option.

The Next button becomes active.

7 Click Next to continue.

The Select Installation Folder page opens.

8 Type or select the path where you want to install the Client Configuration 
Utility.

9 Click Next to continue.

The Ready to Install page opens.

10 Click Install.

The wizard installs the Client Configuration Utility on the system.

11 Click Finish.
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Customizing Images Used by the Windows Client

You can customize the images that Windows clients use by providing alternate 
versions of the images from a local folder or web server virtual directory

Image Editing Guidelines and Considerations

The following guidelines and considerations apply to customized images:

• All custom images must retain their original file name.

• All custom images must retain their original relative path from the 
icons/obj16 folder.

• You only need to save customized images in the branded/obj16 folder. If 
the Service Manager client does find updated images in the branded/
obj16 folder it uses the default images in the icons/obj16 folder.

• Providing custom images from a web server allows you to automatically 
update images without having to reinstall the Windows client.

Providing Custom Images from a Local Folder

You can use the following steps to provide custom images with the repackaged 
client. This image customization method increases the amount of hard disk 
space required to install the Service Manager Windows client as the custom 
images are installed in addition to the default images.

Follow these steps to customize images from a local folder:

1 Copy the images from the Service Manager client into a temporary folder.

The Service Manager client images are located in the following folder: 
C:\Program Files\HP\Service Manager 7.10\Client\plugins\ 
com.hp.ov.sm.client.eclipse.user_7.10\src\resources\icons
\obj16

2 Edit the images you want to customize in the temporary folder.

See Image Editing Guidelines and Considerations on page 112.

3 Delete any images that you do not customize from the temporary folder.

4 Run the Client Configuration Utility and select the local images option.
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The Client Configuration Utility creates the following new folder in the 
Service Manager client installation: 
C:\Program Files\HP\Service Manager 7.10\Client\plugins\ 
com.hp.ov.sm.client.eclipse.user_7.10\src\resources\icons
\branded\obj16

5 Copy your custom images to the branded\obj16 folder.

6 Repackage the client as a zip file or another distribution format of your 
choice.

Providing Custom Images from a Web Server Virtual Directory

You can use the following steps to provide custom images from a central web 
server. This image customization method does not increase the amount of 
hard disk required to install the Service Manager Windows client. In addition, 
any changes you make to images on a web server are automatically applied to 
Windows clients.

Follow these steps to customize images from web server virtual directory:

1 Create a virtual directory on your web server to store the custom images.

2 Copy the images from the Service Manager client into a temporary folder.

The Service Manager client images are located in the following folder: 
C:\Program Files\HP\Service Manager 7.10\Client\plugins\ 
com.hp.ov.sm.client.eclipse.user_7.10\src\resources\icons
\obj16

3 Edit the images you want to customize in the temporary folder.

See Image Editing Guidelines and Considerations on page 112.

4 Delete any images that you do not customize from the temporary folder.

5 Copy your custom images to the virtual directory on your web server.

6 Run the Client Configuration Utility and select the web server virtual 
directory option.

The Client Configuration Utility configures the Service Manager client to 
point to the URL of your web server virtual directory.

Tip:

You can copy the your custom images to the local folder while the 
Client Configuration Utility is open.
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Customizing the Windows Client

In order to use the Client Configuration Utility, you must have previously 
installed a Windows client. 

Follow these steps to create a custom Windows client:

1 Click Start > Programs > Service Manager Client Configuration Utility > Service 
Manager Client Configuration Utility.

The Client Configuration Utility opens.

2 Click Next to continue.

The Specify Service Manager Directory page opens.

3 Type or select the path to an existing installation of the Service Manager 
Windows client.

4 Click Next to continue.

The Change Startup Splash Image page opens.

5 Do one of the following:

• Click Skip to use the default splash image.

• Type or select the path to the splash screen image you want to use.

The default splash screen image is named splash.gif and is located in the 
following folder: 
C:\Program Files\HP\Service Manager 7.10\Client\plugins\ 
com.hp.ov.sm.client.eclipse.user_7.10\src\resources\icons
\obj16

Use the following guidelines to edit the splash screen image:

• The image must retain its original file name

• The image must be in the Windows bitmap (gif) file format

• The image should be approximately 500 wide by 600 pixels high. The 
Client Configuration Utility crops larger images to this size.

6 Click Next to continue.

The Replace Provider and Application Strings page opens.
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7 Do one of the following:

• Click Skip to use the default application text strings.

• Type the text strings you want to use for the following items:

8 Click Next to continue.

The Customize Where Service Manager Application Images are Located 
page opens.

9 Do one of the following:

• Use the default application images.

– No customization: Select this option to use the default images.

– Click Skip.

• Select the path to your customized Windows client images.

– Locally: The Client Configuration Utility creates a folder named 
\branded\obj16 where you can place customized images to 
override the default Windows client images.

– Remotely: Type the URL where the Windows client can access 
customized images.

See Customizing Images Used by the Windows Client on page 112 for 
more information.

10 Click Next to continue.

The Customize Default Login Options page opens.

Table 1 Provider and application settings

Field Type this information

Provider Type the company name you want to display in the Windows 
client interface. The default name is Hewlett-Packard 
Development Company, L.P.

Application Type the application name you want to display in the Windows 
client interface. The default name is Service Manager.
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11 Do one of the following:

• Click Skip if you do not want to create a default connection.

• Select whether to display the following options on Connections dialog 
box of your customized client.

• Type the following information about the default connection you want 
to create.

Table 2 Connection dialog configuration options

Field Description

Show the 
"Remember my 
password" option. 

Enabled by default. When disabled, the client’s 
Connections dialog box will not display the “Remember 
my password” check box option.

Show the server 
parameters. 

Enabled by default. When disabled, the client’s 
Connections dialog box will not display the "Use Login/
Password" and "Use Trusted Sign-on" radio buttons, or 
the "Server host name" and "Server port number". Also, 
the New and Delete buttons will be disabled.

Show the 
"Advanced" 
options page. 

Enabled by default. When disabled, the client’s 
Connections dialog box will not display the "Advanced" 
notebook tab. Additionally, the "Trace SOAP Traffic" 
feature will not be available.

Table 3 Default connection dialog configuration options 

Field Description

Hostname Type the network name or IP address of the Service 
Manager server to which you want the Windows client 
to connect.

Port Number Type the communications port on which the Service 
Manager server listens to client connection requests. 
The default communications port is 13080.
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• Click Next to continue.

The Use and Configure Help Server page opens.

12 Do one of the following:

• Click Skip if you do not want to provide online help from a Help Server.

• Select the Use Central Help Server option to establish a connection to a 
Help Server. Type the following Help Server information.

Compress 
Messages

Select true to enable message compression between the 
Windows client and the Service Manager server. Select 
false to have messages remain uncompressed.

Use SSL 
Connection

Select true to enable an SSL connection between the 
Windows client and the Service Manager server. Select 
false to use a standard connection.

CA Certificate 
Path

Type or select the local path to the CA certificate used 
by your SSL connection. Leave this entry blank if you 
are not using an SSL connection.

You can find a sample CA certificate file cacerts in the following 
path: 
C:\Program Files\HP\Service Manager 7.10\Client\ 
plugins\com.hp.commons_7.10\

Table 3 Default connection dialog configuration options (cont’d)

Field Description

Table 4 Help server configuration options

Field Description

Help Server 
Host

Type the network name of the Service Manager Help 
Server to which you want the Windows client to connect.

Help Server 
Port

Type the communications port on which the Service 
Manager Help Server listens to client connection requests. 
The default communications port is 80.
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• Click Next to continue. The Client Configuration Utility page opens.

13 Click Exit.

The client is now configured and can be zipped or otherwise packaged for 
distribution.

The Help Server host and port must be identical to the settings you 
configured with the Help Server configuration wizard. See Help 
Server Installation on page 99 for more information.
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8 Search Engine Installation
You can install the HP Service Manager search engine on a Windows or Unix 
server. This section contains information about installation requirements as 
well as how to install the and configure the search engine.

The Knowledge Management applications are installed with the regular 
server installation, however the search engine must be installed separately.

Topics in this section include:

• Installing the Service Manager Search Engine on page 120

• Installing the Search Engine by Using the Installation Wizard on 
page 121

• Installing the Search Engine by Using the Text-Based Installer on 
page 124

• Starting and Stopping the Search Engine on page 126

• Configuring the Search Engine on page 127

• Indexing Data with the Search Engine on page 129
 119



Installing the Service Manager Search Engine

There are two ways of installing the Service Manager search engine. You can 
install the search engine by using an installation wizard, or by using a 
text-based installer. After installing the search engine, you can configure the 
search engine settings.

Installation Requirements

• 512 MB RAM

• 4-6 GB disk space

• 800 MHz or higher processor

• 400 MB of space designated for/tmp (Unix) and \TEMP (Windows)

Kernel Resource Requirements for HP-UX

To run Knowledge Management on HP-UX, configure the following kernel 
parameters:

The Linux installer includes JVM, but for other operating systems, you install 
JVM in order to run the search engine installer. 

Table 1 Knowledge Management kernel resource requirements for 
HP-UX 

Value Setting

maxdsiz 1.9 GB (0x7B033000)

maxfiles 2048 KB

maxfiles_lim 2048 KB

maxssiz 160 MB (0xA000000)

max_thread_proc 1024

maxswapchunks 8192

maxtsiz 1 GB (0x40000000)
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Installing the Search Engine by Using the Installation Wizard

Follow these steps to install the Service Manager search engine by using the 
installation wizard:

1 Insert the search engine installation DVD into the appropriate drive of the 
server.

2 Start the Service Manager search engine installation wizard.

3 If you are installing on a Windows system that has auto-run enabled, the 
wizard starts automatically. If auto-run is disabled, you can manually 
start the wizard by using one of the following methods.

On Windows systems

• From the GUI, navigate to the DVD directory.

Double-click setupwin32.exe.

– From the command prompt:

– Type the following:

– D:\>setupjwin32

where D identifies the DVD drive. Substitute your DVD drive 
identifier.

maxuprc 512

maxusers 128

nkthread 1024

nproc 517

Table 1 Knowledge Management kernel resource requirements for 
HP-UX (cont’d)

Value Setting
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On Unix systems

For HP-UX, be sure that you have set the kernel configuration parameters 
described in Kernel Resource Requirements for HP-UX on page 120.

• From the GUI:

– Mount the DVD and navigate to the DVD directory.

– Double-click the executable script that matches your Unix system, 
for example, setupsolaris for Solaris systems or setupaix for 
AIX systems.

• From the command prompt:

– Mount the DVD, and change directories to the mount location. 

– Run the executable script that matches your Unix system, for 
example:  
./setupsolaris for Solaris systems 
or  
./setupaix for AIX systems

The Service Manager Search Engine Setup wizard opens.

4 Click Next to read and accept the licensing agreement.

5 Select the I accept the terms in the License Agreement option. The Next 
button becomes active.

6 Click Next to provide the following installation parameters.

Table 2 Search engine installation parameters

Parameter Value

Hostname Server host name
If the search engine will be on a separate machine on a 
separate domain, use the fully qualified domain, for 
example, my.machine.mydomain.com.

Masterport The default is 9950.

Docserver Port  
(9920-9949)

The default is 9948.

Indexer Port  
(9960-9979)

The default is 9967.
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7 Click Next to provide the installation directory.

The default installation directory for Windows is: 
C:\Program Files\HP\Service Manager 7.10\Search Engine

If necessary, click Browse to choose a different location.

8 Click Next to review the installation summary information.

9 Click Install to begin copying the installation files.  
To stop the installation click Cancel.

The InstallShield Wizard opens a dialog box when the installation is 
complete.

10 If you are on a Unix system, run InstallConfiguration.sh, which is 
found in your <Search Engine install path>/directory.

11 Click Finish to exit the Wizard.

Record these settings, you will need them to configure Service 
Manager to communicate with the search engine.
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Installing the Search Engine by Using the Text-Based 
Installer

Follow these steps to install the Service Manager search engine using the 
text-based installer:

1 Insert the search engine installation DVD into the appropriate drive of the 
server.

2 Run the installer.

3 On Windows systems:

Open the command prompt and type the following:

D:\>setupwin32 -console

where D identifies the DVD drive. Substitute your DVD drive identifier.

On Unix systems:

a Mount the DVD and change directories to the mount location.

b Run the executable script that matches your Unix system, for 
example: ./setupsolaris -console for Solaris systems or ./
setupaix -console for AIX systems.

4 At the installation script prompt, type yes to agree to the license 
agreement.

5 At the installation script prompt, type the installation directory address 
where you want to install Service Manager.

The system takes several minutes to read the contents of the DVD, 
uncompress the files, and create a logs directory.

6 At the installation script prompt, type a host name, then press Enter.

7 At the installation script prompt, type a Masterport number, then press 
Enter. The default is 9950.

The system validates any directory name that you specify. If you 
specify an invalid directory, the installation generates an error 
message.

If the search engine will be on a separate domain, use the fully 
qualified domain, for example, mymachine.mydomain.com.
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8 At the installation script prompt, type a Docserver Port number 
(9920-9949), then press Enter. The default is 9948.

9 At the installation script prompt, type an Indexer Port number 
(9960-9979), then press Enter. The default is 9967.

10 The server installation completes.

11 If you are on a Unix system, run InstallConfiguration.sh, which is 
found in your <Search Engine install path>/directory.

Record these settings, you will need them to configure Service 
Manager to communicate with the search engine.
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Starting and Stopping the Search Engine

On Windows Systems

The installer creates a service named KMSearch. Use it to start and stop the 
search engine. This service starts automatically after installation.

On Unix Systems

Add the following to the sm.ini file:

For HP-UX

plugin0:libkmplugin.sl

For all other versions of Unix

plugin0:libkmplugin.so

There are two executable scripts in your installation folder.

Run the k2adminstart.sh executable script file to start the index service for 
your search engine.

Table 3 Search engine start scripts for Unix systems

Name Purpose

k2adminstart.sh Starts the search engine and index service 

k2adminstop.sh Stops the search engine and index service 
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Configuring the Search Engine

Before you can use the search engine, you must set up connectivity, and then 
index the search engine.

Connecting to the Search Engine

Follow these steps to connect to the search engine:

1 Log in with a user with the KM ADMIN profile.

2 Open System Administration > Ongoing Maintenance > Environment Records > 
Knowledge Management Environment.

3 To Assign the Default Knowledge View Group to all operators, select the check 
box.

4 Specify the Host Name of Search Server. This must be identical to the host 
name you indicated when installing the server.

5 You can confirm that you have the correct information by looking in the 
configuration file at C:\Program Files\HP\Service Manager 
7.10\Search Engine\KMSearch.cfg.

6 Click Verify Server to verify connectivity to the search engine.

7 Specify the Mapped drive for Style files. The path is default is C:\Program 
Files\HP\Service Manager 7.10\Search Engine\data\stylesets.

8 Click Verify Path to verify that your path and map settings are correct.

9 Make sure that both the search engine and Service Manager server have 
read and write privileges in the stylesets folder.

10 Specify the Search Engine administration port number. This must be identical 
to the port number you indicated when installing the server. If you did not 
change the default port number, use the default given in the field.

If the search engine is installed on a separate machine, you will 
need to share the stylesets folder from the search engine to the 
Service Manager server. Use the share name and path for this 
setting so that the style files path in the environment form is set to 
the stylesets folder. 
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11 Specify the Search Engine indexer port number. This must be identical to the 
port number you indicated when installing the server. If you did not 
change the default port number, use the default given in the field.

12 Specify the Search Engine search port number. This must be identical to the 
port number you indicated when installing the server. If you did not 
change the default port number, use the default given in the field.

13 Specify the Max number of Documents returned from a search.

14 Specify the Default expiration period. The time limit specified here will be 
over-ridden if the user specified an expiration date when they created a 
document by using the Contribute New Document function.

15 Specify the Style text for search results. Use this style sheet to control the 
appearance of the information the search returns. This is similar to an 
HTML css stylesheet.

16 Log out of Service Manager, and log back in again.
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Indexing Data with the Search Engine

Certain actions require a full reindex. These actions include the following:

• Initial setup (no indexes exist)

• Changing any value on the Type Information tab or the Field Definitions 
tab

You may also want to do a full reindex if:

• There are a large number of changes or new documents

• Search performance is becoming sluggish

As updates are applied to the index, they are added in as incremental index 
files. If you have a knowledge base that has had many changes applied, these 
incremental index files can slow the search engine down since it must perform 
your query on each one. A full reindex builds a new clean index that performs 
better, similar to defragmenting a hard drive. Doing a full reindex on a large 
knowledge base can have a significant impact on system resources because it 
removes all changes for the knowledge base from the change cache.

Index data with the search engine

Follow these steps to index data with the search engine:

1 Log in with a user with the KM ADMIN profile.

2 Open Services > Knowledge Management > Administration > Manage 
KnowledgeBases.

3 Click Search to bring up a list of knowledge bases.

4 For each knowledge base, check that the information is correct, and click 
Full Reindex. Refer to the field help for descriptions of each field.

5 If the index does not exist, it will be created. If it does exist, it will be 
deleted and recreated. The Docs field will not be blank after an index has 
been created.

After the Indexes have been created, users will be able to access the indexed 
documents the next time they log in.

You can only reindex or get status for your knowledge base if the search 
engine has been properly configured on the environment page. A message box 
will notify you if the search engine cannot be found.
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A Legacy Integrations
Using legacy integrations with the Service Manager server requires you to set 
up a read-only legacy ServiceCenter listener. A legacy integration is any 
integration that depends on SCCL32 or the ServiceCenter ODBC driver. 
These include Connect-It, Get-It, and Crystal Reports.

This appendix provides information on how to set up a legacy listener and 
connect to Service Manager, as well as how to set up the ServiceCenter ODBC 
driver. 

Topics in this appendix include:

• Overview on page 132

• Editing the sc.ini File on page 133

• Installing the Windows Service on page 134

• Starting a Legacy Listener on page 135

• Installing the ODBC Driver on page 136

• Configuring the ODBC Driver on page 137
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Overview

You will need to complete the following tasks in order to connect to Service 
Manager using SCCL32 or the legacy ServiceCenter ODBC driver. 

Task 1: Editing the sc.ini File on page 133

Task 2: Installing the Windows Service on page 134

Task 3: Starting a Legacy Listener on page 135 (Windows servers only)

Task 4: Installing the ODBC Driver on page 136

Task 5: Configuring the ODBC Driver on page 137

While the server runs on both Windows or Unix platforms. The ODBC driver 
runs only on Windows. 
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Editing the sc.ini File

The out-of-box server sc.ini file is configured to connect to the Demo 
Database. To connect to another RDBMS, edit the parameters in sc.ini. 
Windows users also need to add the ntservice parameter to the sc.ini file. 
This parameter provides the name used to identify the Windows service. 

Follow these steps to edit the sc.ini file:

1 Log in to the Service Manager server with an administrator account.

2 Open a command prompt and navigate to  
<Service Manager 7.10 installation path>\Server\ 
LegacyIntegration\RUN. 

3 Open the file sc.ini with a text editor.

4 To connect to your Service Manager RDBMS, add the database 
connectivity settings. These match the settings you used in Database 
Preparation on page 21.

5 Windows users only: Add the following parameter on its own line. 
ntservice:<Service Manager Legacy Readonly Service Name>

6 Save the file and exit. 

Unix users proceed to Starting a Legacy Listener on page 135.

Windows users continue with the next section, Installing the Windows 
Service.
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Installing the Windows Service

You can create a separate Windows service to use with the legacy ODBC 
driver. You can manually install a ServiceCenter Windows service on any 
machine where you have already installed Service Manager server.

Follow these steps to install the Windows service:

1 Log in to the Windows server as a user with local administrator privileges.

2 Open a command prompt and navigate to  
<Service Manager 7.10 installation path>\Server\ 
LegacyIntegration\RUN. 

3 Type scservic -install.

This command creates a Windows service with the name specified by the 
ntservice parameter in the sc.ini file.

Uninstalling the Windows Service

You can manually remove the Windows service on any machine where you 
have already installed Service Manager server.

Follow these steps to uninstall the Windows service:

1 Log in to the Service Manager server with an administrator account.

2 Open a command prompt and navigate to  
<Service Manager 7.10 installation path>\Server\ 
LegacyIntegration\RUN. 

3 Type scservic -remove.

This command removes the Windows service with the name specified by the 
ntservice parameter in the sc.ini file.
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Starting a Legacy Listener

You can start a read-only ServiceCenter listener in the background. Since this 
is not an instance of Service Manager it will not show up in your System 
Status window. 

Unix 

Follow these steps to start a listener for your legacy integration on Unix 
servers.

1 Navigate to C:\Program Files\HP\Service Manager 7.10\Server\ 
LegacyIntegration\RUN

2 Run the scstart script.

Windows

Follow these steps to start a listener for your legacy integration on Windows 
servers.

1 In Windows, open Start > Control Panel > Administrative 
Tools > Services. 

2 Select the service you installed in Installing the Windows Service on 
page 134, and click Start.

If you prefer, you can start the listener as an application instead of a service 
by running the following command at the Windows command prompt, from 
the <installation path> \Service Manager 7.10\Server\ 
LegacyIntegration\RUN directory.  
scenter -listener:<port number> -RPCReadOnly
135



Installing the ODBC Driver

Follow these steps to install the legacy ServiceCenter ODBC driver.

1 Log in to the Windows server as a user with local administrator privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

3 If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. 

4 If auto-run is disabled, follow these steps to start the DVD browser 
manually.

5 Navigate to the DVD directory. 

6 Open clickme.htm.

7 Click Install ODBC Driver.

The ServiceCenter ODBC Driver InstallShield Wizard opens.

8 Click Next to read and accept the licensing agreement.

9 Select the I accept the terms in the License Agreement option.

The Next button becomes active.

10 Click Next to select your installation folder. 

The default installation location is:

C:\Program Files\Peregrine Systems\ServiceCenter 6.2\ODBC Driver

If necessary, click Browse to choose a different location.

11 Click Next to prepare the installation process.

12 Click Install to begin copying the installation files.

You can stop the installation by clicking Cancel.

A dialog box opens when the installation is complete. 

13 Click Finish to exit.
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Configuring the ODBC Driver

The default installation sets up the ODBC DSN to connect to the default 
legacy listener, and assumes it is on the local host. To connect to your legacy 
listener, you will need to edit these settings.

Follow these steps to configure the legacy ODBC driver to connect to the 
legacy read-only listener:

1 From the Windows Start menu, click Control Panel > Administrative Tools > 
Data Source (ODBC).

2 Open the System DSN tab.

3 Select sc_report_odbc and click Configure.

4 Configure the ODBC driver by using the following parameters.

5 Verify that the ODBC driver can connect. 

To test the connection, use any ODBC query tool. For example, in Excel, 
open: Data > Get External Data > New Database Query. Choose 
the ServiceCenter ODBC driver as your data source. If it connects, you 
will see the HP Service Manager tables.

Table 4 ODBC parameters

Field Value

Data Source Name sc_report_odbc

Server The host where the legacy ServiceCenter listener is 
running. 
The out-of-box default is localhost.

Port The port the legacy server is set to use. 
 The out-of-box default is 12690.
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Crystal Reports

The Service Manager installation DVD comes with out-of-box reports that you 
can run using Crystal Reports. Using those reports requires the ServiceCenter 
ODBC driver. This driver is installed when you run the Service Manager 
ODBC driver installer. 

Follow these steps to download the reports.

1 Log in to the Windows server as a user with local administrator privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

3 Select the Downloads tab.

4 Click Download Reports for HP Service Manager. 

A folder containing the available reports opens. 

5 Copy the desired reports to your local directory.

Refer to your Crystal Report documentation for information on how to run the 
reports. 
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